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We thank all our beta testers for their input and obvious enthusiasm for the East software.
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Finally, we dedicate this software package to our families and to the memory of our dearly
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Our Philosophy
We would like to share with you what drives and inspires us during the research and
development stages of the East software.

Empower, do not Frustrate
We believe in making simple, easy-to-use software that empowers people.

We believe that statisticians have a strategic role to play within their organization and that by
using professionally developed trial design software they will utilize their time better than if
they write their own computer programs in SAS or R to create and explore complex trial
designs. With the help of such software they can rapidly generate many alternative design
options that accurately address the questions at hand and the goals of the project team,
freeing time for strategic discussions about the choice of endpoints, population, and
treatment regimens.

We believe that software should not frustrate the user’s attempt to answer a question. The
user experience ought to engage the statistician and inspire exploration, innovation, and the
quest for the best design. To that end, we believe in the following set of principles:

Fewer, but Important and Useful Features It is better to implement fewer, but important
and useful features, in an elegant and simple-to-use manner, than to provide a host of
options that confuse more than they clarify.
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As Steve Jobs put it: ’Innovation is not about saying ”Yes” to everything. It’s about saying
”No” to all but the most crucial features.’
Just because we Can, doesn’t mean we Should Just because we can provide functionality
in the software, doesn’t mean we should.
Simplify, Simplify, Simplify Find and offer simple solutions - even for the most complex
trial design problems.
Don’t Hurry, but continually Improve Release new solutions when they are ready to use
and continually improve the commercial releases with new features, bug fixes, and better
documentation.
Provide the best Documentation and Support Our manuals are written like textbooks, to
educate, clarify, and elevate the statistical knowledge of the user.
Our support is provided by highly competent statisticians and software engineers,
focusing on resolving the customer’s issue, and being mindful of the speed and quality
requirements. We believe that delivering delightful customer support is essential to our
company’s lifeblood.

Finally, we listen to our customers constantly and proactively through countless informal and
formal interactions, software trainings, and user group meetings. This allows us to follow all
the principles laid out above in the most effective manner.

Our Philosophy – Empower, do not Frustrate v
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1 Installing East 6.2

1.1 System Requirements to run East 6.2

The minimum hardware/operating system requirements for East 6.2 are:
A system running one of the following operating systems:

– Windows XP (32 or 64 bit)

– Windows 7 (32 or 64 bit)

A minimum of 512 MB RAM (1 GB recommended)
A hard disk with at least 300 MB of free disk space

1.2 Installation

To install East 6.2, please follow these steps:
1. If any copy (including a beta or demo version) of East 6.2 is currently installed on your
PC, please uninstall it or else the installation of the current version will not proceed
correctly. To uninstall the earlier version of East 6.2, go to the Start Menu and select
Programs→ East 6.2→ Uninstall East 6.2

2. Insert the East 6.2 CD into your CD-drive.

(a) If your Windows Autorun Default is already active, you’ll see an installation screen
similar to what is shown below. Follow the instructions that will appear on the

1.2 Installation 3
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screen.

(b) If your Windows Autorun Default is not active, you won’t see any installation screen.
In that case, open your Windows Explorer, click on the CD Drive, and double-click
on Setup. Then you will see the installation screen . Follow the instructions that will
appear on the screen.

4 1.2 Installation
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2 Getting Started

East has evolved over the past several years with MS Excel R⃝ as the user interface. The East on
MS Excel R⃝ did not integrate directly with any other Cytel products. Under the Architect
platform, East is expected to coexist and integrate seamlessly with other Cytel products such
as SiZ, and Compass. Architect is a common platform designed to support various Cytel
products. It provides a user-friendly, Windows-standard graphical environment, consisting of
tabs, icons, and dialog boxes, with which you can design, simulate and analyze. Throughout
the user manual, this product is referred to as East 6.

One major advantage of East 6 is the facility for creating multiple designs. This is achieved by
giving multiple inputs of the parameters as either comma separated, or in a range such as
(a:b:c) with a as the initial value, b as the last value and c as the step size. If you give
multiple values for more than one parameter, East creates all possible combinations of the
input parameters. This is an immense advancement over earlier versions of East, where you
had to create one design at a time. Furthermore, one could not compare different types of
designs (e.g., superiority vs. noninferiority designs). Similarly, graphical comparison of designs
with different numbers of looks was difficult with earlier versions of East. All such comparisons
are readily available in East 6.

We have also provided powerful data editors to create, view, and modify data. A wide variety
of statistical tests are now a part of East 6, which enables you to conduct statistical analysis of
interim data for continuous, discrete and time to event endpoints.

Simulations help to develop better insight into the operating characteristic of a design. In East
6, the simulation module has now been enhanced to allow fixed or random allocation to
treatment and control, and different sample sizes. Such options were not possible with earlier
versions of East.

Chapter 2 5
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Another new feature is the option to add assumptions for accruals and dropouts. Previously
this was available for survival, but has been extended to continuous and discrete endpoints in
East 6. Information about accrual rates, response lag, and dropouts can be given whether
designing or simulating a trial. This makes more realistic, end-to-end simulation of a trial
possible.

The purpose of this chapter is to familiarize you with the East 6 user interface.

2.1 Workflow in Architect

In this section, the structure of Architect platform is explained. The logical workflow in which
the different parts of the interface co-ordinate with each other is discussed.

The basic structure of the interface items is depicted in the following diagram.

Besides the top Ribbon, there are mainly four main windows in East 6 namely, (starting from
left), the Library, the Input / Output window, the Output Preview area and the Help Pane.
Note that both the Library and the Help Pane can be auto-hidden temporarily or throughout
the session, allowing the other windows to occupy larger area on the screen for display.

6 2.1 Workflow in Architect
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Initially, Library shows only the Root node. As you work with East, multiple designs,
simulation scenarios, data sets and related analysis can be managed using this panel. Various
nodes for outputs and plots are created in the Library, facilitating work on multiple scenarios
at a time. The width of the Library window can be adjusted for better readability.

The central part of the interface, the Input / Output, is the main work area where you can-
Enter input parameters for design computation create and compare multiple designs,
view plots
Simulate a design under different scenarios
Perform interim analysis on a group sequential design look by look and view the results,
receive decisions such as stopping or continuing during the execution of a trial
Open a data on which you want to perform analysis, enter new data, view outputs,
prepare a report etc.

This is the area where the user interacts with the product most frequently.

The Output Preview area compiles several outputs together in a grid like structure where
each row is either a design or simulation run. This area is in use only when working with
Design or Simulations.

2.1 Workflow in Architect 7
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When the Compute or Simulate button is clicked, all requested designs or simulation results
are computed and are listed in rows in the Output Preview area:

By clicking different rows of interest while simultaneously holding the Ctrl key, either a single
or multiple designs can be displayed in the Output Summary in vertical manner or

8 2.1 Workflow in Architect
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side-by-side comparison can be done.

Note that the active window and the Output Preview can be minimized, maximized, or

resized. If you want to focus on the Output Summary, click the icon in the top-right
corner of the main window. The Output will be maximized as shown below:

2.1 Workflow in Architect 9
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Any of the designs/simulations in the Output Preview area can be saved in the Library, as
depicted in the following workflow diagram.

Double click any of these nodes and the detailed output of the design will be displayed. This
will include all relevant input and output information. Right clicking any design node in the
Library will allow you to perform various operations on the design such as interim monitoring
and simulation.

The Help Pane displays the context sensitive help for the control currently under the focus.
This help is available for all the controls in the Input / Output window. This pane also displays
the design specific help which discusses the purpose of the selected test, the published
literature referred while developing it and finally the user manual references to quickly look-up
for more details in the East6 User Manual. This pane can be hidden or locked by clicking the
pin symbol.

10 2.1 Workflow in Architect
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All the windows and features mentioned above are described in detail with the help of an
illustration in the subsequent sections of this chapter.

2.2 A Quick Overview of User Interface

Almost all the functionalities of East 6 are invoked by selecting appropriate menu items and
icons from the Ribbon. The interface consists of four windows as described in the previous
section and four major menu items. These menu items are:

Home. This menu contains typical file-related Windows sub-menus. The Help sub-menu
provides access to this manual.
Data Editor. This menu will be available once a data set is open, providing several
sub-menus used to create, manage and transform data.
Design. This menu provides a sub-menu for each of the study designs which can be
created using East 6. The study designs are grouped according to nature of the
response. The tasks like Simulations and Interim Monitoring are available for almost all
the study designs under this menu.
Analysis. This menu provides a sub-menu for each of the analysis procedure that can be
carried out in East 6. The tests are grouped according to the nature of the response.
There are also options for basic statistics and plots.

2.2 A Quick Overview of User Interface 11
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2.3 Home Menu

The Home menu contains a variety of submenus:

2.3.1 File

Click this icon to create new case data or crossover data. A new workbook or log can
also be created.

Click this icon to open a saved data set, workbook, or log file.

Click this icon to import external files created by other programs.

Click this icon to export files in various formats.

Click this icon to save the current files or workbooks.

Click this icon to save a file or workbook with different name.

2.3.2 Importing workbooks from East5.4

East allows the conversion of workbooks previously created in East 5.4 (and above) to be
imported into East 6 for further development. In order to open a workbook with the .es5
extension given by previous versions of East, it must first be converted to a file with the .cywx
extension that will be recognized by East 6. This is easily accomplished through the Covert

12 2.3 Home Menu – 2.3.2 Importing workbooks from East5.4
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Old Workbook utility. Click on the icon under Home menu to see the location of this
utility.

From the Windows Start menu under All Programs, select Covert Old Workbook located in
the Cytel Architect folder:

We can see the following window which accepts East5.4 workbook as input and outputs a
workbook of East6. Click the Browse buttons to choose the East 5.4 file to be converted and
the file to be saved with .cywx extension of East 6 version. To start the conversion click
Convert Workbook:

Once complete, the file can be opened as a workbook in East 6 through Home–> File–>
Open.

2.3 Home Menu – 2.3.3 Settings 13
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2.3.3 Settings

Click the icon in the Home menu to adjust default values in East 6.

The options provided in the Display Precision tab are used to set the decimal places of
numerical quantities. The settings indicated here will be applicable to all tests in East 6 under
the Design and Analysis menus.
The General tab has the provision of adjusting the paths for storing workbooks, files, and
temporary files. These paths will remain throughout the current and future sessions even after
East is closed. This is the place where we need to specify the installation directory of the R
software in order to use the feature of R Integration in East6.

14 2.3 Home Menu – 2.3.3 Settings
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The Design Defaults is where the user can change the settings for trial design:

Under the Common tab, default values can be set for input design parameters. Under the
Group Sequential tab, defaults are set for boundary information. When a new design is
started, input fields will contain these specified defaults.

Simulation Defaults is where we can change the settings for simulation:

2.3 Home Menu – 2.3.3 Settings 15
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The Chart Settings allows defaults to be set for the following quantities on East6 charts:

2.3.4 View

The View submenu consists of enabling or disabling the Help and Library panes by
(un)checking the respective check boxes.

2.3.5 Window

TheWindow submenu contains an Arrange and Switch option. This provides the ability to
view different standard arrangements of available windows (Design Input Output, Log, Details,

2.3 Home Menu – 2.3.5 Window 17
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charts and plots) and to switch the focus from one window to another.

2.3.6 Help

The Help submenu provides the following ways to access the East6 documenatation:

User Manual: Invoke the current East 6 user manual.
Tutorial: Invoke the available East 6 tutorials.
About East 6: Displays the current version and license information for the installed
software.
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3 Tutorial: Normal Endpoint

This tutorial introduces you to East on the Architect platform, using an example clinical trial to
test difference of means.

3.1 Fixed Sample Design

When you open East, you will see the following screen below.

By default, the Design tab in the ribbon will be active. The items on this tab are grouped under
the following categories of endpoints: Continuous, Discrete, Count, Survival, and General. Click

3.1 Fixed Sample Design 21
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Continuous: Two Samples, and then Parallel Design: Difference of Means.

The following input window will appear.

By default, the radio button for Sample Size (n) is selected, indicating that it is the variable to
be computed. The default values shown for Type I Error and Power are 0.025 and 0.9. Keep
the same for this design. Since the default inputs provide all of the necessary input
information, you are ready to compute sample size by clicking the Compute button. The

22 3.1 Fixed Sample Design
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calculated result will appear in the Output Preview pane, as shown below.

This single row of output contains relevant details of inputs and the computed result of total

sample size (and total completers) of 467. Select this row, and click to display a
summary of the design details in the upper pane (known as Output Summary).

The discussion so far gives you a quick feel of the software for computing sample size for a
single look design. We will describe further features in an example for a group sequential
design in the next section.

3.1 Fixed Sample Design 23
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3.2 Group Sequential Design for a Normal Superiority Trial

3.2.1 Study Background

Drug X is a newly developed lipase inhibitor for obesity management that acts by inhibiting the
absorption of dietary fats. The performance of this drug needs to be compared with an already
marketed drug Y for the same condition. In a randomized, double-blind, trial comparing the
efficacy and safety of 1 year of treatment with X to Y (each at 120 mg for three times a day),
obese adults are to be randomized to receive either X or Y combined with dietary intervention
for a period of one year. The endpoint is weight loss (in pounds). You are to design a trial
having 90% power to detect a mean difference of 9 lbs between X and Y, assuming 15 lbs and
6 lbs weight loss in each treatment arm, respectively, and a common standard deviation of 32
lbs. The design is required to be a 2-sided test at the 5% significance level.

From the design menu choose Continuous: Two Samples, and then Parallel Design:
Difference of Means. Select 2­Sided for Test Type, and enter 0.05 for Type I Error. Specify
theMean Control be 6, theMean Treatment to be 15, and the common Std. Deviation to
be 32. Next, change the Number of Looks to be 5. You will see a new tab, Boundary Info,
added to the input dialog box.

Click the Boundary Info tab, and you will see the following screen. On this tab, you can
choose whether to specify stopping boundaries for efficacy, or futility, or both. For this trial,

24 3.2 Group Sequential Design – 3.2.1 Study Background
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choose efficacy boundaries only, and leave all other default values. We will implement the
Lan-Demets (O’Brien-Fleming) spending function, with equally spaced looks.

On the Boundary Info tab, click on the icons or , to generate the following

3.2 Group Sequential Design – 3.2.1 Study Background 25
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charts.

Click Compute. East will show the results in the Output Preview.
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The maximum combined sample size required under this design is 544. The expected sample
sizes under H0 and H1 are 540 and 403, respectively. Click in the Output Preview
toolbar to save this design to Wbk1 in the Library. Double-click on Des1 to generate the
following output.

Once you have finished examining the output, close this window, and re-start East before
continuing.

3.2.2 Creating multiple designs easily

In East, it is easy to create multiple designs by inputting multiple parameter values. In the trial
described above, suppose we want to generate designs for all combinations of the following
parameter values: Power = 0.8, 0.9, and Difference in Means = 8.5, 9, 9.5, 10. The number of
such combinations is 2× 4 = 8.

East can create all 8 designs by a single specification in the input dialog box. Enter the
following values as shown below. Remember that the common Std. Deviation is 32. From the
Input Method, select the Difference of Means option. The values of Power have been
entered as a list of comma-separated values, while Difference in Means has been entered as

3.2 Group Sequential Design – 3.2.2 Creating multiple designs easily 27



<<< Contents * Index >>>

Chapter 3: Tutorial: Normal Endpoint

a colon-separated range of values: 8.5 to 10 in steps of 0.5.

Now click compute. East computes all 8 designs, and displays them in the Output Preview as

shown below. Click to maximize the Output Preview.

Select the first 3 rows using the Ctrl key, and click to display a summary of the design
details in the upper pane, known as the Output Summary.

Select Des1 in the Output Preview, and click toolbar to save this design in the Library.
We will use this design for simulation and interim monitoring, as described below. Now that
you have saved Des1, delete all designs from the Output Preview before continuing, by

selecting all designs with the Shift key, and clicking in the toolbar.

28 3.2 Group Sequential Design – 3.2.2 Creating multiple designs easily



<<< Contents * Index >>>

East
R⃝
6.4

c⃝ Cytel Inc. Copyright 2017

3.2.3 Simulation

Right-click Des1 in the Library, and select Simulate. Alternatively, you can select Des1 and

click the icon.

We will carry out a simulation of Des1 to check whether it preserves the specified power. Click
Simulate. East will execute by default 10000 simulations with the specified inputs. Close the
intermediate window after examining the results. A row labeled as Sim1 will be added in the
Output Preview.

Click the icon to save this simulation to the Library. A simulation sub-node will be
added under Des1 node. Double clicking on the Sim1 node, will display the detailed
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simulation output in the work area.

In 80.23% of the simulated trials, the null hypothesis was rejected. This value is very close to
the specified power of 80%. The next section will explore interim monitoring with this design.
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3.2.4 Interim Monitoring

Right-click Des1 in the Library and select Interim Monitoring. Click the to
open the Test Statistic Calculator. Suppose that after 91 subjects, at the first look, you have
observed a mean difference of 8.5, with a standard error of 6.709.

Click OK to update the IM Dashboard.

The Stopping Boundaries and Error Spending Function charts on the left:
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The Conditional Power and Confidence Intervals charts on the right:

Suppose that after 182 subjects, at the second look, you have observed a mean difference of
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16, with a standard error of 4.744. Click Recalc, and then OK to update the IM Dashboard. In
this case, a boundary has been crossed, and the following window appears.

Click Stop to complete the trial. The IM Dashboard will be updated accordingly, and a table
for Final Inference will be displayed as shown below.
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4 Normal Superiority
One-Sample

To compare a new process or treatment to a well-established control, a single-sample study
may suffice for preliminary information prior to a full-scale investigation. This single sample
may either consist of a random sample of observations from a single treatment when the
mean is to be compared to a specified constant or a random sample of paired differences or
ratio between two treatments. The former is presented in Section (4.1) and the latter is
discussed in Section (4.2) and Section (4.3).

4.1 Single Mean
4.1.1 Trial Design 4.1.2 Simulation 4.1.3 Interim Monitoring
4.1.4 Trial Design Using a t-Test (Single Look)

The problem of comparing the mean of the distribution of observations from a single random
sample to a specified constant is considered. For example, when developing a new drug for
treatment of a disease, there should be evidence of efficacy. For this single-sample problem, it
is desired to compare the unknown mean µ to a fixed value µ0. The null hypothesis H0: µ = µ0

is tested against the two-sided alternative hypothesis H1: µ ̸= µ0 or a one-sided alternative
hypothesis H1: µ < µ0 or H1: µ > µ0. The power of the test is computed at a specified value
of µ = µ1 and standard deviation σ.

Let µ̂j denote the estimate of µ based on nj observations, up to and including the j-th look,
j = 1, ...,K , with a maximum of K looks. The test statistic at the j-th look is based on the
value specified by the null hypothesis, namely

Zj = n
1/2
j (µ̂j − µ0)/σ̂j , (4.1)

where σ̂2
j is the sample variance based on nj observations.
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4.1.1 Trial Design

Consider the situation where treatment for a certain infectious disorder is expected to result in
a decrease in the length of hospital stay. Suppose that hospital records were reviewed and it
was determined that, based on this historical data, the average hospital stay is approximately 7
days. It is hoped that the new treatment can decrease this to less than 6 days. It is assumed
that the standard deviation is σ = 2.5 days.The null hypothesis H0: µ = 7(= µ0) is tested
against the alternative hypothesis H1: µ < 7.

First, click Continuous: One Sample on the Design tab and then click Single Arm Design:
Single Mean as shown below.

This will launch a new input window.

Single-Look Design
We want to determine the sample size required to have power of 90% when µ = 6(= µ1),

using a test with a one-sided type-1 error rate of 0.05. Choose Test Type as 1­Sided. Specify
Mean Response under Null (µ0) as 7,Mean Response under Alt. (µ1) as 6 and Std.
Deviation (σ) as 2.5. The upper pane should appear as below:

Click Compute. This will calculate the sample size for this design and the output is shown as a
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row in the Output Preview. The computed sample size is 54 subjects.

This design has default name Des 1. Select this design by clicking anywhere along the row and

click in the Output Preview toolbar. Some of the design details will be displayed in the
upper pane, labeled as Output Summary.

In the Output Preview toolbar select Des 1, click to save this design to Wbk1 in the
Library.

Five-Look Design
To allow the opportunity to stop early and proceed with a full-scale plan, five equally-spaced
analyses are planned, using the Lan-DeMets (O’Brien-Fleming) stopping boundary. Create a
new design by right-clicking Des 1 in the Library, and selecting Edit Design. In the Input,
change the Number of Looks from 1 to 5, to generate a study with four interim looks and a
final analysis. A new tab for Boundary Info should appear. Click this tab to reveal the
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stopping boundary parameters. By default, the Spacing of Looks is set to Equal, which
means that the interim analyses will be equally spaced in terms of the number of patients
accrued between looks. The left side contains details for the Efficacy boundary, and the right
side contains details for the Futility boundary. By default, there is an efficacy boundary (to
reject H0) selected, but no futility boundary (to reject H1). The Boundary Family specified is
of the Spending Functions type. The default Spending Function is the Lan­DeMets (Lan
& DeMets, 1983), with Parameter as OF (O’Brien-Fleming), which generates boundaries that
are very similar, though not identical, to the classical stopping boundaries of O’Brien and
Fleming (1979). For a detailed description of the different spending functions and stopping
boundaries available in East refer to Chapter ??. The cumulative alpha spent and the boundary
values are displayed below.

Click Compute. The maximum and expected sample sizes are highlighted in yellow in the
Output Preview. Save this design in the current workbook by selecting the corresponding
row in the Output Preview and clicking on the Output Preview toolbar. To compare

Des 1 and Des 2, select both rows in Output Preview using the Ctrl key and click in the
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Output Preview toolbar. This will display both designs in the Output Summary pane.

Des 2 results in a maximum of 56 subjects in order to attain 90% power, with an expected
sample size of 40 under the alternative hypothesis. In order to see the stopping probabilities,
double-click Des 2 in the Library.

The clear advantage of this sequential design resides in the relatively high cumulative
probability of stopping by the third look if the alternative is true, with a sample size of 34
patients, which is well below the requirements for a fixed sample study (54 patients). Close the
Output window before continuing.

Examining stopping boundaries and spending functions
You can plot the boundary values of Des 2 by clicking on the Library toolbar, and then
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clicking Stopping Boundaries. The following chart will appear:

You can choose different boundary scales from the drop down box located in the right hand
side. The available boundary scales are Z scale, Score Scale, µ/σ Scale and p-value scale. To
plot the error spending function for Des 2, select Des 2 in the Library, click in the
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toolbar, and then click Error Spending. The following chart will appear:

The above spending function is according to Lan and DeMets (1983) with O’Brien-Fleming
flavor and for one-sided tests has the following functional form:

α(t) = 2− 2Φ

(
Zα/2√

t

)

Observe that very little of the total type-1 error is spent early on, but more is spent rapidly as
the information fraction increases, and reaches 0.05 at an information fraction of 1. Feel free to
try other plots by clicking in the Library toolbar. Close all charts before continuing.

4.1.2 Simulation

Suppose we want to see the advantages of performing the interim analyses, as it relates to the
chance of stopping prior to the final analysis. This examination can be conducted using
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simulation. Select Des 2 in the Library, and click in the toolbar. Alternatively, right-click
on Des 2 and select Simulate. A new Simulation window will appear. For example, suppose
you wish to determine how quickly this trial could be terminated if the treatment difference
was much greater than expected. For example, under the alternative hypothesis, µ = 4.5. Click
on the Response Generation Info tab, and specify: Mean Response(µ) = 4.5 and Std.
Deviation (σ) = 2.5.

Click Simulate to start the simulation. Once the simulation run has completed, East will add an
additional row to the Output Preview labeled as Sim 1.

Select Sim 1 in the Output Preview and click . Now double-click on Sim 1 in the
Library. The simulation output details will be displayed in the upper pane.

Observe that 100% simulated trials rejected the null hypothesis, and about 26% of these
simulations were able to reject the null at the first look after enrolling only 11 subjects. Your
numbers might differ slightly due to a different starting seed.
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4.1.3 Interim Monitoring

Suppose that the trial has commenced and Des 2 was implemented. Right-click Des 2 in the
Library, and select Interim Monitoring.

Although we specified that there will be five equally spaced interim looks, the Lan-DeMets
methodology implemented in East allows you to alter the number and spacing of these looks.
Accordingly, suppose that an interim look was taken after enrolling 20 subjects and the sample
mean, based on these 20 subjects, was 5.1 with a standard error of 0.592. Since µ0 = 7, based
on equation (4.1) the value of the test statistic at the first look would be Z1 = (5.1− 7)/0.592

or -3.209.

Click Enter Interim Data on the toolbar. In the Test Statistic Calculator, enter the following
values, and click Recalc and thenOK.

Since the stopping boundary is crossed, the following dialog box appears.
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Click Stop to take you back to the interim monitoring dashboard. For final inference, East will
display the following summary information on the dashboard.

4.1.4 Trial Design Using a t-Test (Single Look)

The sample size obtained to correctly power Des 1 in Section (4.1.1) relied on using a
Wald-type statistic for the hypothesis test, given by equation (4.1). Due to the assumption of
normal distribution for the test statistic, we have ignored the fact that the variance σ is
estimated from the sample. For large sample sizes this approximation is acceptable. However,
in small samples with unknown standard deviation the test statistic

Z = n1/2(µ̂− µ0)/σ̂, (4.2)

is distributed with student’s t distribution with (n− 1) degrees of freedom. Here, σ̂2 denotes
the sample variance based on n observations.

Consider the example in Section 4.1.1 where we would like to test the null hypothesis that the
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average hospital stay is 7 days, H0: µ = 7(= µ0), against the alternative hypothesis that is less
than 7 days, H1: µ < 7. We will now design the same trial in a different manner, using the t
distribution for the test statistic.

Right-click Des 1 in the Library, and select Edit Design. In the input window, change the Test
Stat. from Z to t. The entries for the other fields need not be changed.

Click Compute. East will add an additional row to the Output Preview labeled as Des 3. The

required sample size is 55. Select the rows corresponding to Des 1 and Des 3 and click .
This will display Des 1 and Des 3 in the Output Summary.

Des 3, which uses the t distribution, requires that we commit a combined total of 55 patients
to the study, just one more compared to Des 1, which uses the normal distribution. The extra
patient is needed to compensate for the extra variability due to estimation of the var[δ̂].

4.2 Mean of Paired Differences
4.2.1 Trial Design 4.2.2 Simulation 4.2.3 Interim Monitoring
4.2.4 Trial Design Using a t-Test (Single Look)

The paired t-test is used to compare the means of two normal distributions when each
observation in the random sample from one distribution is matched with a unique observation
from the other distribution. Let µc and µt denote the two means to be compared and let σ2

denote the variance of the differences.

The null hypothesis H0: µc = µt is tested against the two-sided alternative hypothesis
H1: µc ̸= µt or a one-sided alternative hypothesis H1: µc < µt or H1: µc > µt. Let δ = µt − µc.
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The null hypothesis can be expressed as H0: δ = 0 and the alternative can be expressed as
H1: δ ̸= 0, H1: δ > 0, or H1: δ < 0. The power of the test is computed at specified values of
µc, µt, and σ.

Let µ̂cj and µ̂tj denote the estimates of µc and µt based on nj observations, up to and
including j-th look, j = 1, . . . ,K where a maximum of K looks are to be made. The estimate
of the difference at the j-th look is

δ̂j = µ̂tj − µ̂cj

and the test statistic at the j-th look is

Zj = n
1/2
j δ̂j/σ̂j , (4.3)

where σ̂2
j is the sample variance of nj paired differences.

4.2.1 Trial Design

Consider the situation where subjects are treated once with placebo after pain is
experimentally induced, and later treated with a new analgesic after pain is induced a second
time. Pain is reported by the subjects using a 10 cm visual analog scale (0=“no pain”, . . . ,
10=“extreme pain”). After treatment with placebo, the average is expected to be 6 cm. After
treatment with the analgesic, the average is expected to be 4 cm. It is assumed that the
common standard deviation is σ = 5 cm. The null hypothesis H0: δ = 0 is tested against the
alternative hypothesis H1: δ < 0.

Start East afresh. First, Continuous: One Sample on the Design tab, and then click Paired
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Design: Mean of Paired Differences

This will launch a new input window.

Single-Look Design
We want to determine the sample size required to have power of 90% when µc = 6 and
µt = 4, using a test with a one-sided type-1 error rate of 0.05. Select Test Type as 1­Sided,
Individual Means for Input Method, and specify theMean Control (µc) as 6 andMean
Treatment (µt) as 4. Enter Std. Dev. of Paired Difference (σ0) as 5. The upper pane should
appear as below:

Click Compute. This will calculate the sample size for this design and the output is shown as a
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row in the Output Preview. The computed sample size is 54 subjects.

This design has default name Des 1. Select this design by clicking anywhere along the row in

the Output Preview and click . Some of the design details will be displayed in the upper
pane, labeled as Output Summary.

In the Output Preview toolbar select Des 1, click to save this design to Wbk1 in the
Library.

Three-Look Design
For the above study, suppose we wish to take up to two equally spaced interim looks and one
final look as we accrue data, using the Lan-DeMets (O’Brien-Fleming) stopping boundary.
Create a new design by right-clicking Des 1 in the Library, and Edit Design. In the Input,
change the Number of Looks from 1 to 3, to generate a study with two interim looks and a
final analysis.

Click Compute. The maximum and expected sample sizes are highlighted in yellow in the
Output Preview. Save this design in the current workbook by selecting the corresponding
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row in Output Preview and clicking on the Output Preview toolbar. To compare

Des 1 and Des 2, select both rows in Output Preview using the Ctrl key and click . Both
designs will be displayed in the Output Summary pane.

Des 2 results in a maximum of 55 subjects in order to attain 90% power, with an expected
sample size of 43 under the alternative hypothesis. In the Output Preview toolbar select
Des 2, click to save this design to Wbk1 in the Library. In order to see the stopping
probabilities, double-click Des 2 in the Library.

The clear advantage of this sequential design resides in the high cumulative probability of
stopping by the third look if the alternative is true, with a sample size of 37 patients, which is
well below the requirements for a fixed sample study (54 patients). Close the Output window
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before continuing.

Select Des 2 and click on the Library toolbar. You can select one of many plots,
including one for Stopping Boundaries:

Close this chart before continuing.

4.2.2 Simulation

Select Des 2 in the Library, and click in the toolbar. Click on the Response Generation
Info tab, and make sureMean Treatment(µt) = 4,Mean Control(µc) = 6 and Std. Deviation
(σ) = 5. Click Simulate. Once the simulation run has completed, East will add an additional
row to the Output Preview labeled as Sim 1.

Select Sim 1 in the Output Preview and click . Now double-click on Sim 1 in the

50 4.2 Mean of Paired Differences – 4.2.2 Simulation



<<< Contents * Index >>>

East
R⃝
6.4

c⃝ Cytel Inc. Copyright 2017

Library. The simulation output details will be displayed.

Overall, close to 90% of simulations have rejected H0. The numbers on your screen might
differ slightly due to a different seed.

4.2.3 Interim Monitoring

For an ongoing study we evaluate the test statistic at an interim stage to see whether we have
enough evidence to reject H0. Right-click Des 2 in the Library, and select Interim Monitoring.

Although the design specified that there be three equally spaced interim looks, the
Lan-DeMets methodology implemented in East allows you to alter the number and spacing of
these looks. Suppose that an interim look was taken after enrolling 18 subjects and the sample
mean, based on these subjects, was -2.2 with a standard error of 1.4. Then based on equation
(4.3), the value of the test statistic at first look would be Z1 = (−2.2)/1.4 or -1.571.

Click Enter Interim Data on the toolbar. In the Test Statistic Calculator, enter the following
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values, and click Recalc and thenOK.

The dashboard will be updated accordingly.

As the observed value -1.571 has not crossed the critical boundary value of -3.233, the trial
continues. Now, 18 additional subjects are enrolled, and a second interim analysis with 36
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subjects is conducted. Suppose that the observed difference is -2.3 with standard error as 0.8.
Select the Look 2 row and click Enter Interim Data. Enter these values, and click Recalc, and
thenOK.

Since the stopping boundary is crossed, the following dialog box appears. Click on Stop.

For final inference, East will display the following summary information on the dashboard.
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4.2.4 Trial Design Using a t-Test (Single Look)

The sample size obtained to correctly power the trial in Section (4.2.1) relied on using a
Wald-type statistic for the hypothesis test, given by equation (4.3). However, we neglected the
fact that the variance σ is estimated by assuming that the test statistic follows a standard
normal distribution. For large sample sizes, asymptotic theory supports this approximation. In
a single-look design, this test statistic is calculated as

Z = n1/2δ̂/σ̂, (4.4)

where σ̂2 is the sample variance based on n observed paired differences. In the following
calculations we take into consideration that Z follows a Student’s t-distribution with (n− 1)

degrees of freedom.

Consider the example in Section 4.2.1 where we would like to test the null hypothesis that the
analgesic does not reduce pain, H0: δ = 0, against the alternative hypothesis that the new
analgesic works to reduce pain, H1: δ < 0. We will design this same trial using the t
distribution for the test statistic.

Right-click Des 1 from the Library, and select Edit Design. Change the Test Stat. from Z to t.
The entries for the other fields need not be changed, and click Compute. East will add an
additional row to the Output Preview labeled as Des 3. Select the rows corresponding to
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Des 1 and Des 3. This will display Des 1 and Des 3 in the Output Summary.

Using the t distribution, we need one extra subject to compensate for the extra variability due
to estimation of the var[δ̂].

4.3 Ratio of Paired Means

The test for ratio of paired difference is used to compare the means of two log normal
distributions when each observation in the random sample from one distribution is matched
with a unique observation from the other distribution. Let µc and µt denote the two means to
be compared and let σ2

c adn σ2
t are the respective variances.

The null hypothesis H0: µc/µt = 1 is tested against the two-sided alternative hypothesis
H1: µc/µt ̸= 1 or a one-sided alternative hypothesis H1: µc/µt < 1 or H1: µc/µt > 1. Let
ρ = µt/µc. Then the null hypothesis can be expressed as H0: ρ = 1 and the alternative can be
expressed as H1: ρ ̸= 1, H1: ρ > 1, or H1: ρ < 1. The power of the test is computed at specified
values of µc, µt, and σ. We assume that σt/µt = σc/µc i.e., the coefficient of variation (CV) is
the same under both control and treatment.

4.3.1 Trial Design

Start East afresh. Click Continuous: One Sample on the Design tab, and then click Paired
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Design: Mean of Paired Ratios as shown below.

This will launch a new window. The upper pane of this window displays several fields with
default values. Select Test Type as 1­Sided, and Individual Means for Input Method.
Specify theMean Control (µc) as 4 andMean Treatment (µt) as 3.5. Enter Std. Dev. of Log
ratio as 0.5. The upper pane should appear as below:

Click Compute. This will calculate the sample size for this design and the output is shown as a
row in the Output Preview. The computed sample size is 121 subjects (or pairs of
observations).

This design has default name Des 1. In the Output Preview toolbar select Des 1, click
to save this design to Wbk1 in the Library.
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4.3.2 Trial Design Using a t-test

Right-click Des 1 in the Library and select Edit Design. In the input window, change the Test
Stat. from Z to t.

Click Compute. East will add an additional row to the Output Preview labeled as Des 2.

Select the rows corresponding to Des 1 and Des 2 using the Ctrl key and click . This will
display Des 1 and Des 2 in the Output Summary.

Des 2 uses the t distribution and requires that we commit a combined total of 122 patients to
the study, one more compared to Des 1, which uses a normal distribution.
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5 Normal Noninferiority
Paired-Sample

Two common applications of the paired sample design include: (1) comparison of two
treatments where patients are matched on demographic and baseline characteristics, and (2)
two observations made from the same patient under different experimental conditions. The
type of endpoint for paired noninferiority design could be difference of means or ratio of
means. The former is presented in Section 5.1 and the latter is discussed in Section 5.2. For
paired sample noninferiority trials, East can be used only when no interim look is planned.

5.1 Mean of Paired Differences
5.1.1 Trial Design 5.1.2 Trial Design Using a t-Test (Single Look) 5.1.3 Simulation

Consider a randomized clinical trial comparing an experimental treatment, T, to a control
treatment, C, on the basis of outcome variable, X, with means µt and µc, respectively, and with
a standard deviation of paired difference as σ2

D . Here, the null hypothesis H0: µt − µc ≤ δ0 is
tested against the one-sided alternative hypothesis H1: µt − µc > δ0. Here δ0 denotes the
noninferiority margin and δ0 < 0. Let δ = µt − µc. Then the null hypothesis can be expressed
as H0: δ ≤ δ0 and the alternative can be expressed as H1: δ > δ0.

Here we assume that the each paired observation on X from T and C are distributed according
to a bivariate normal distribution with means as (µt, µc) , variances as (σ2

t , σ2
c ) and correlation

coefficient as ρ. Let us have N such paired observations from T and C and µ̂c and µ̂t denote
the estimates of µc and µt based on these N pairs. Therefore, the estimate of the difference is
δ̂ = µ̂t − µ̂c. Denoting the standard error of δ̂ by se(δ̂), the test statistic can be defined as

Z =
δ̂ − δ0

se(δ̂)
(5.1)
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The test statistic Z is distributed as a t distribution with (N − 1) degrees of freedom. For large
samples, the t-distribution can be approximated by the standard normal distribution. The
power of the test is computed at specified values of µc, µt, and σD . East allows you to analyze
using both normal and t distribution.

The advantage of the paired sample noninferiority design compared to the two independent
sample noninferiority design lies in the smaller se(δ̂) in former case. The paired sample design
is more powerful than the two independent sample design: to achieve the same level of
power, the paired sample design requires fewer subjects.

5.1.1 Trial Design

Iezzi et. al. (2011) investigated the possibility of reducing radiation dose exposure while
maintaining the image quality in a prospective, single center, intra-individual study. In this
study, patients underwent two consecutive multidetector computed tomography angiography
(MDCTA) scans 6 months apart, one with a standard acquisition protocol (C) and another using
a low dose protocol (T). Image quality was rated as an ordinal number using a rating scale
ranging from 1 to 5. Let µc and µt denote the average rating of image quality for standard
acquisition and low dose protocol, respectively, and δ = µt − µc be the difference between two
means. Based on the 30 samples included in the study, µc and µt were estimated as 3.67 and
3.12, respectively. The noninferiority margin for image quality considered was −1. Accordingly,
we will design the study to test

H0 : δ ≤ −1 against H1 : δ > −1

The standard deviation of paired difference was estimated as 0.683. We want to design a study
with 90% power at µc = 3.67 and µt = 3.12 and that maintains overall one-sided type I error of
0.025.

First, click Continuous: One Sample on the Design tab and then click Paired Design: Mean
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of Paired Differences as shown below.

This will launch a new window. Select Noninferiority for Design Type, and Individual
Means for Input Method. Specify theMean Control (µc) as 3.67,Mean Treatment (µt) as
3.12, and the Std. Dev. of Paired Difference (σD) as 0.683. Finally, enter −1 for the
Noninferiority Margin (δ0). Leave all other entries with their default values. The upper pane
should appear as below:

Click Compute. This will calculate the sample size for this design and the output is shown as a
row in the Output Preview located in the lower pane of this window. The computed sample
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size (25 subjects) is highlighted.

This design has default name Des 1. You can select this design by clicking anywhere along the

row in the Output Preview. Select this design and click in the Output Preview toolbar.
Some of the design details will be displayed in the upper pane, labeled as Output Summary.

A total of 25 subjects must be enrolled in order to achieve the desired 90% power under the
alternative hypothesis. In the Output Preview select Des 1 and click in the toolbar to
save this design to Wbk1 in the Library.

The noninferiority margin of −1 considered above is the minimal margin. Since the observed
difference is only little less than -0.5 we would like to calculate sample size for a range of
noninferiority margins, say, −0.6, −0.7, −0.8, −0.9 and −1. This can be done easily in East. First

select Des 1 in the Library, and click on the Library toolbar. In the Input, change the
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Noninferiority Margin (δ0) −0.6 : −1 : −0.1.

Click Compute to generate sample sizes for different noninferiority margins. This will add 5
new rows to the Output Preview. There will be a single row for each of the noninferiority
margins.

The computed sample sizes are 1961, 218, 79, 41 and 25 with noninferiority margins −0.60,
−0.7, −0.8, −0.9 and −1, respectively. To compare all 5 designs, select last 5 rows in Output

Preview, and click . The 5 designs will be displayed in the Output Summary pane.

Suppose we have decided to go with Des 3 to test the noninferiority hypothesis with
noninferiority margin of −0.7. This requires a total sample size of 218 to achieve 90% power.
Select Des 3 in the Output Preview and click in the toolbar to save this design to
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Wbk1 in the Library. Before we proceed we would like to delete all designs from the Output

Preview. Select all rows and then either click in the toolbar, or click Delete after right
click. To delete the designs from the workbook in Library select the corresponding designs
individually (one at a time) and then click Delete after right click. You can try deleting Des 1
from the Library.

Plotting
With Des 3 selected in the Library, click on the Library toolbar, and then click Power
vs Sample Size. The resulting power curve for this design will appear.

You can move the vertical bar along the X axis. To find out power at any sample size, move the
vertical bar to that sample size and the numerical value of sample size and power will be
displayed on the right of the plot.You can export this chart in one of several image formats
(e.g., Bitmap or JPEG) by clicking Save As.... Close this chart before continuing. In a similar
fashion one can see power vs delta plot by clicking and then Power vs Treatment
Effect.
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You can obtain the tables associated with these plot by clicking , and then clicking the
appropriate table. Close the plots before continuing.

5.1.2 Trial Design Using a t-Test (Single Look)

The sample size obtained to correctly power Des 3 relied on using a Wald-type statistic for the
hypothesis test. Due to the assumption of a normal distribution for the test statistic, we have
ignored the fact that the variance σ is estimated from the sample. For large sample sizes, this
approximation is acceptable. However, in small samples with unknown standard deviation, the
test statistic

Z = (δ̂ − δ0)/se(σ̂)

is distributed as Student’s t distribution with (n− 1) degrees of freedom where n is the
number of paired observations.

Select Des 3 from the Library, and click . This will take you to the input window. Now
change the Test Statistic from Z to t. The entries for the other fields need not be changed.

Click Compute. East will add an additional row to the Output Preview. The required sample
size is 220. This design uses the t distribution and it requires us to commit a combined total of
220 patients to the study, two more compared to Des 3 which uses the normal distribution.
The extra couple of patients are needed to compensate for the extra variability due to
estimation of the var[δ̂].

5.1.3 Simulation

Select Des 3 in the Library, and click in the toolbar. Alternatively, right-click on Des 3
and select Simulate. A new Simulation window will appear. Click on the Response
Generation Info tab, and specify: Mean control = 3.67,Mean Treatment = 3.12, and Std.
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Deviation of Paired Difference (σD)= 0.683.

Leave all default values, and click Simulate. Once the simulation run has completed, East will
add an additional row to the Output Preview labeled as Sim 1.

Select Sim 1 in the Output Preview and click . Double-click Sim 1 in the Library, and
the simulation output details will be displayed in the right pane under the Simulation tab.

Notice that the percentage of rejections out of 10000 simulated trials is consistent with the
design power of 90%. The exact result of the simulations may differ slightly, depending on the
seed.

Now we wish to simulate from a point that belongs to H0 to check whether the chosen design
maintains type I error of 5%. Right-click Sim 1 in the Library and select Edit Simulation. Go to
the Response Generation Info tab in the upper pane and specify: Mean control = 3.67,
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Mean Treatment = 2.97, and Std. Deviation of Paired Difference (σD) = 0.683.

Click Simulate. Once the simulation run has completed, East will add an additional row to the
Output Preview labeled as Sim 2. Select Sim 2 in the Output Preview and click . Now
double-click on Sim 2 in the Library. The simulation output details will be displayed.

The upper efficacy stopping boundary was crossed close to the specified type I error of 2.5%.
The exact result of the simulations may differ slightly, depending on the seed.

5.2 Ratio of Paired Means

Consider a randomized clinical trial comparing an experimental treatment, T, to a control
treatment, C, on the basis of outcome variable, X, with means µt and µc, respectively, and let
σ2
t and σ2

c denote the respective variances. The null hypothesis H0: µt/µc ≤ ρ0 is tested
against the one-sided alternative hypothesis H1: µt/µc > ρ0. Here, ρ0 denotes the
noninferiority margin and ρ0 < 1. Let ρ = µt/µc. Then the null hypothesis can be expressed as
H0: ρ ≤ ρ0 and the alternative can be expressed as H1: ρ > ρ0.
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Let us have N such paired observations from T and C and (Xit, Xic) denotes the ith pair of
observations (i = 1, · · · , N ). Then logXit − logXic = log (Xit/Xic) denotes the logarithm of
ratio of means for ith subject. We assume that the paired log-transformed observations on X
from T and C, (logXit, logXic) are bivariate normally distributed with common parameters. In
other words, (Xit, Xic) is distributed as bivariate log-normal distribution.

Denote logXit by yit, logXic by yic, and the corresponding difference by δyi = yit − yic.
Assume that δ̂y denotes the sample mean for these paired differences with estimated standard
error se(δ̂y). The test statistic can be defined as

Z =
δ̂y − log ρ0

se(δ̂y)
, (5.2)

The test statistic Z is distributed as a t distribution with (N − 1) degrees of freedom. For large
samples, the t-distribution can be approximated by the standard normal distribution. East
allows you to analyze using both normal and t distribution. The power of the test is computed
at specified values of µc, µt, and σ.

5.2.1 Trial Design

We will use the same example cited in the previous section, but will transform the difference
hypothesis into the ratio hypothesis. Let µc and µt denote the average rating of image quality
for standard acquisition and low dose protocol, estimated as 3.67 and 3.12, respectively. Let
ρ = µt/µc be the ratio between two means. Considering a noninferiority margin of −0.7 for
the test of difference, we can rewrite the hypothesis mentioned in previous section as

H0 : ρ ≤ 0.81 against H1 : ρ > 0.81

We are considering a noninferirority margin of 0.81(= ρ0). For illustration we will assume the
standard deviation of log ratio as 0.20. As before, we want to design a study with 90% power
at µc = 3.67 and µt = 3.12, and maintains overall one-sided type I error of 0.025.

Start East afresh. Click Continuous: One Sample on the Design tab and then click Paired
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Design: Mean of Paired Ratios as shown below.

This will launch a new window. The upper pane of this window displays several fields with
default values. Select Noninferiority for Design Type, and Individual Means for
Input Method. Specify theMean Control (µc) as 3.67,Mean Treatment (µt) as 3.12, and
Noninferiority margin (ρ0) as 0.81. Enter 0.20 for Std. Dev. of Log Ratio, and 0.025 for Type
I Error (α). The upper pane now should appear as below:

Click Compute. This will calculate the sample size for this design and the output is shown as a
row in the Output Preview located in the lower pane of this window. The computed sample
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size (180 subjects) is highlighted in yellow.

This design has default name Des 1. You can select this design by clicking anywhere along the

row in the Output Preview. Select this design and click in the Output Preview toolbar.
Some of the design details will be displayed in the upper pane, labeled as Output Summary.

A total of 180 subjects must be enrolled in order to achieve the desired 90% power under the
alternative hypothesis. In the Output Preview select Des 1 and click in the toolbar to
save this design to Wbk1 in the Library.

Suppose you think enrolling 180 subjects is too much for your organization and you can go up
to only 130 subjects. You want to evaluate the power of your study at sample size 130 but with
the design parameters remain unaltered. In order to compute power with 130 subjects, first

select the Des 1 in the Library, and click on the Library toolbar. In the Input dialog
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box, first select the radiobutton for Power, and then enter 130 for Sample Size.

Now click Compute. This will add another row labeled as Des 2 in Output Preview with
computed power highlighted in yellow. The design attains a power of 78.7%. Now select both

the rows in Output Preview by pressing the Ctrl key, and click in the Output Preview
toolbar to see a summary of both designs in the Output Summary.

In the Output Preview select Des 2 and click in the toolbar to save this design to
Wbk1 in the Library.

Plotting
With Des 2 selected in the Library, click on the Library toolbar, and then click Power
vs Sample Size . The resulting power curve for this design will appear. You can move the
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vertical bar along the X axis.

Suppose you would like to explore the relationship between power and standard deviation. In
order to visualize this relationship, select Des 2 in the Library, click on the Library
toolbar, and then click General (User Defined Plot). Select Std Dev of Log Ratio for
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X-Axis. This will display the power vs. standard deviation plot.

Close the plot window before you continue.

5.2.2 Simulation

Select Des 2 in the Library, and click in the toolbar. Alternatively, right-click on Des 2
and select Simulate. A new Simulation window will appear. Click on the Response
Generation Info tab, and specify: Mean control = 3.67,Mean Treatment = 3.12, and Std
Dev of Log Ratio= 0.2.
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Select Sim 1 in the Output Preview and click . Now double-click on Sim 1 in the
Library. The simulation output details will be displayed.
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6 Binomial Superiority
One-Sample

This chapter deals with the design, simulation, and interim monitoring of two types of tests
involving binomial response rates. In Section 6.1, we discuss group sequential designs in which
an observed binomial response rate is compared to a fixed response rate, possibly derived
from historical data. Section 6.2 deals with McNemar’s test for comparing matched pairs of
binomial responses in a group sequential setting.

6.1 Binomial One Sample
6.1.1 Trial Design 6.1.2 Trial Simulation 6.1.3 Interim Monitoring

In experimental situations, where the variable of interest has a binomial distribution, it may be
of interest to determine whether the response rate π differs from a fixed value π0. Specifically
we wish to test the null hypothesis H0: π = π0 against the two sided alternative hypothesis
H1: π ̸= π0 or against one sided alternatives of the form H1: π > π0 or H1: π < π0. The sample
size, or power, is determined for a specified value of π which is consistent with the alternative
hypothesis, denoted π1.

6.1.1 Trial Design

Consider the design of a single-arm oncology trial in which we wish to determine if the tumor
response rate of a new cytotoxic agent is at least 15%. Thus, it is desired to test the null
hypothesis H0: π = 0.15 against the one-sided alternative hypothesis H1: π > 0.15. We will
design this trial with a one sided test that achieves 80% power at π = π1 = 0.25 with a
one-sided level 0.05 test.

Single-Look Design To begin, click Design tab, then Single Sample under Discrete group,
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and then click Single Proportion.

In the ensuing dialog box , choose the design parameters as shown below. We first consider a
single-look design, so leave the default value for Number of Looks to 1. In the drop down
menu, next to Test Type select 1-Sided. Enter 0.8 for Power. Enter 0.15 in the box next to
Prop. Response under Null (π0) and 0.25 in the box next to Prop. Response under Alt (π1).
This dialog box also asks us to specify whether we wish to standardize the test statistic (for
performing the hypothesis test of the null hypothesis H0: π = 0.15) with the null or the
empirical variance. We will discuss the test statistic and the method of standardization in the
next subsection. For the present, select the default radio button Under Null Hypothesis.

Now click Compute. The design is shown as a row in the Output Preview located in the lower
pane of this window. The sample size required in order to achieve the desired 80% power is 91
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subjects.

You can select this design by clicking anywhere on the row in the Output Preview. Click
icon to get the design output summary displayed in the upper pane. In the Output Preview
toolbar, click icon to save this design Des1 to workbook Wbk1 in the Library. If you
hover the cursor over the node Des1 in the Library, a tooltip will appear that summarizes the
input parameters of the design.

With the design Des1 selected in the Library, click icon on the Library toolbar, and then
click Power vs. Treatment Effect (δ). The power curve for this design will be displayed. You
can save this chart to the Library by clicking Save in Workbook. Alternatively, you can export
the chart in one of several image formats (e.g., Bitmap or JPEG) by clicking Save As.... For now,
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you may close the chart before continuing.

Three-Look Design In order to reach an early decision and enter into comparative trials, let
us plan to conduct this single-arm study as a group sequential trial with a maximum of 3 looks.

Create a new design by selecting Des1 in the Library, and clicking the icon on the
Library toolbar. Change the Number of Looks from 1 to 3, to generate a study with two
interim looks and a final analysis. A new tab Boundary Info will appear. Clicking on this tab
will reveal the stopping boundary parameters. By default, the Spacing of Looks is set to
Equal, which means that the interim analyses will be equally spaced in terms of the number of
patients accrued between looks. The left side contains details for the Efficacy boundary, and
the right side for the Futility boundary. By default, there is an efficacy boundary (to reject H0)
selected, but no futility boundary (to reject H1). The Boundary Family specified is of the
Spending Functions type. The default Spending function is the Lan-DeMets (Lan & DeMets,
1983), with Parameter OF (O’Brien-Fleming), which generates boundaries that are very similar,
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though not identical, to the classical stopping boundaries of O’Brien and Fleming (1979).
Technical details of these stopping boundaries are available in Appendix ??.

Return to the design parameters by clicking Design Parameters tab. The dialog box requires
us to make a selection in the section labeled Variance of Standardized Test Statistic. We are
being asked to specify to East how we intend to standardize the test statistic when we actually
perform the hypothesis tests at the various monitoring time points. There are two options:
Under Null Hypothesis and Empirical Estimate. To understand the difference between these
two options, let π̂j denote the estimate of π based on nj observations, up to and including the
j th monitoring time point.

Under Null Hypothesis The test statistic to be used for the interim monitoring is

Z
(N)
j =

π̂j − π0√
π0(1− π0)/nj

. (6.1)

Empirical The test statistic to be used for the interim monitoring is

Z
(E)
j =

π̂j − π0√
π̂j(1− π̂j)/nj

. (6.2)

The choice of variance should not make much of a difference to the type 1 error or power for
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studies in which the sample size is large. In the present case however, it might matter. We shall
therefore examine both the options. First, we select the Under Null Hypothesis radio button.

Click Compute button to generate output for Design Des2. With Des2 selected in the Output
Preview, click icon to save Des2 to the Library. In order to see the stopping

probabilities, as well as other characteristics, select Des2 in the Library, and click icon.
The cumulative boundary stopping probabilities are shown in the Stopping Boundaries table.
We see that for Des2 the maximum sample size is 91 subjects, with 90 expected under the null
hypothesis H0: π = 0.15 and 73 expected when the true value is π=0.25.

Close the Output window before continuing. The stopping boundary can be displayed by
clicking on the icon on the Library toolbar, and then clicking Stopping Boundaries.
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The following chart will appear.

To examine the error spending function, click icon on the Library toolbar, and then click
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Error Spending. The following chart will appear.

To examine the impact of using the empirical variance to standardized test statistic, select

Des2 in the Library, and click icon on the Library toolbar. In the Variance of
Standardized Test Statistic box, now select Empirical Estimate.

Next, click Compute. With Des3 selected in the Output Preview, click icon. In the

Library, select the nodes Des2 and Des3, by holding the Ctrl key, and then click icon.
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The upper pane will display the summary details of the two designs side-by-side:

The maximum sample size needed for 80% power is 119, and the expected sample size is 99
under the alternative hypothesis H1 with π1 = 0.25, if we intend to standardize the test statistic
with the empirical variance. The corresponding maximum and expected sample sizes if the null
variance is to be used for the standardization are 91 and 73, respectively. Thus, for this
configuration of design parameters, it would appear preferable to specify in advance that the
test statistic will be standardized by the null variance. Evidently, this is the option with the
smaller maximum and expected sample size. These results, however, are based on the large
sample theory developed in Appendix ??. Since the sample sizes in both Des2 and Des3 are
fairly small, it would be advisable to verify that the power and type 1 error of both the plans are
preserved by simulating these designs. We show how to simulate these plans in Section 6.1.2.

In some situations, the sample size is subject to external constraints. Then, the power can be
computed for a specified maximum sample size. Suppose that in the above situation, using
the observed estimates for the computation of the variance, the total sample size is

constrained to be at most, 80 subjects. Select Des3 in the Library and click on the
Library toolbar. Change the selections in the ensuing dialog box so that the trial is now
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designed to compute power for a maximum sample size of 80 subjects, as shown below.

Click Compute button to generate the output for Design Des4. With Des4 selected in the
Output Preview, click icon. In the Library, select the nodes for Des2, Des3, and Des4

by holding the Ctrl key, and then click icon. The upper pane will display the summary
details of the three designs side-by-side:

From this, we can see that Des4 has only 65.5 % power.

6.1.2 Trial Simulation

In Section 6.1.1, we created group sequential designs with two different assumptions for the
manner in which the test would be standardized at the interim monitoring stage. Under Des2,
we assumed that the null variance, and hence the test statistic (6.1) would be used for the
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interim monitoring. This plan required a maximum sample size of 91 subjects. Under Des3, we
assumed that the empirical variance, and hence the test statistic (6.2) would be used for the
interim monitoring. This plan required a maximum sample size of 119 subjects. Since the
sample sizes for both plans are fairly small and the calculations involved the use of large
sample theory, it would be wise to verify the operating characteristics of these two plans by
simulation.

Select Des2 in the Library, and click the icon from Library toolbar. Alternatively,
right-click on Des2 node and select Simulate. A new Simulation worksheet will appear.

Click Simulate to start the simulation. Once the simulation run has completed, East will add an
additional row to the Output Preview labeled Sim1. Select Sim1 row in the Output Preview

and click icon. Note that some of the simulation output details will be displayed in the
upper pane. Click icon to save it to the Library. Double-click on Sim1 node in the
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Library. The simulation output details will be displayed.

Upon running 10,000 simulations with π = 0.25 we obtain slightly over 80% power as shown
above.

Next we run 10,000 simulations under H0 by setting π = 0.15 in the choice of simulation

parameters. Select Des2 in the Library, and click icon from Library toolbar. Under the
Response Generation Info tab, change the Proportion Response to 0.15. Click Simulate to
start the simulation. Once the simulation run has completed, East will add an additional row to
the Output Preview labeled Sim2. Select Sim2 in the Output Preview. Click icon to
save it to the Library. Double-click on Sim2 in the Library. The simulation output details will
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be displayed.

We observe that 6% of these simulations reject the null hypothesis thereby confirming that
these boundaries do indeed preserve the type 1 error (up to Monte Carlo accuracy).

Finally we repeat the same set of simulations for Des3. Select Des3 in the Library, and click

icon from Library toolbar. Upon running 10,000 simulations with π = 0.25, we obtain
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82% power.

However, when we run the simulations under H0: π = 0.15, we obtain a type 1 error of about
3.23% instead of the specified 5% as shown below. While this ensures that the type 1 error is
preserved, it also suggests that the use of the empirical variance rather than the null variance
to standardize the test statistic might be problematic with small sample sizes.
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Let us now investigate if the problem disappears with larger studies. Select Des3 in the Library

and click on the Library toolbar. Change the value of Prop. Response under Alt (π1)
from 0.25 to 0.18.

Click Compute to generate the output for Des5. In the Output Preview, we see that Des5
requires a sample size of 1035 subjects. To verify whether the use of the empirical variance will
indeed produce the correct type-1 error for this large trial, select Des5 in the Output Preview

and click icon. In the Library, select Des5 and click icon from Library toolbar .
First, run 10,000 trials with π = 0.15. On the Response Generation Info tab, change
Proportion Response from 0.18 to 0.15. Next click Simulate. Observe that the type-1 error
obtained by simulating Des5 is about 4.5%, an improvement over the corresponding type 1
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error obtained by simulating Des3.

Next, verify that a sample size of 1035 suffices for producing 80% power by running 10,000
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simulations with π = 0.18.

This example has demonstrated the importance of simulating a design to verify that it does
indeed possess the operating characteristics that are claimed for it. Since these operating
characteristics were derived by large-sample theory, they might not hold for small sample
sizes, in which case, the sample size or type-1 error might have to be adjusted appropriately.

6.1.3 Interim Monitoring

Consider interim monitoring of Des3, the design that has 80% power when the empirical
estimate of variance is used to standardize the test statistic. Select Des3 in the Library, and

click icon from the Library toolbar. Alternatively, right-click on Des3 and select Create
IM Dashboard. The interim monitoring dashboard contains various controls for monitoring
the trial, and is divided into two sections. The top section contains several columns for
displaying output values based on the interim inputs. The bottom section contains four charts,
each with a corresponding table to its right. These charts provide graphical and numerical
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descriptions of the progress of the clinical trial and are useful tools for decision making by a
data monitoring committee.

At the first interim look, when 40 subjects have enrolled, suppose that the observed response

rate is 0.35. Click icon to invoke the Test Statistic Calculator. In the box
next to Cumulative Sample Size enter 40. Enter 0.35 in the box next to Estimate of π. In the
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box next to Standard Error of Estimate of π enter 0.07542. Next click Recalc.

Observe that upon pressing the Recalc button, the test statistic calculator automatically
computes the value of the test statistic as 2.652.

6.1 Binomial One Sample – 6.1.3 Interim Monitoring 95



<<< Contents * Index >>>

Chapter 6: Binomial Superiority One-Sample

Clicking OK results in the following output.

Since our test statistic, 2.652, is smaller than the stopping boundary, 3.185, the trial continues.

At the second interim monitoring time point, after 80 subjects have enrolled, suppose that the
estimate of π̂ based on all data up to that point is 0.30. Click on the second row in the table in

the upper section. Then click icon. In the box next to Cumulative Sample
Size enter 80. Enter 0.30 in the box next to Estimate of π. In the box next to Standard Error
of Estimate of π enter 0.05123. Next click Recalc. Upon clicking OK we observe that the
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stopping boundary is crossed and the following message is displayed.

We can conclude that π > 0.15 and terminate the trial. Clicking Stop yields the following
output.

6.2 McNemar’s Test

McNemar’s Test is used in experimental situations where paired comparisons are observed. In
a typical application, two binary response measurements are made on each subject – perhaps
from two different treatments, or from two different time points. For example, in a
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comparative clinical trial, subjects are matched on baseline demographics and disease
characteristics and then randomized with one subject in the pair receiving the experimental
treatment and the other subject receiving the control. Another example is the cross over
clinical trial in which each subject receives both treatments. By random assignment, some
subjects receive the experimental treatment followed by the control while others receive the
control followed by the experimental treatment. Let πc and πt denote the response
probabilities for the control and experimental treatments, respectively. The probability
parameters for McNemar’s test are displayed in Table 6.1.

Table 6.1: A 2 x 2 Table of Probabilities for McNemar’s Test
Experimental Total

Control No Response Response Probability
No Response π00 π01 1− πc

Response π10 π11 πc

Total Probability 1− πt πt 1

The null hypothesis
H0: πc = πt

is tested against the alternative hypothesis

H1: πc ̸= πt

for the two sided testing problem or the alternative hypothesis

H1: πc > πt

(or H1: πc < π) for the one-sided testing problem. Since πt = πc if and only if π01 = π10, the
null hypothesis is also expressed as

H0: π01 = π10 ,

and is tested against corresponding one and two sided alternatives. The power of this test
depends on two quantities:
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1. The difference between the two discordant probabilities (which is also the difference
between the response rates of the two treatments)

δ = π01 − π10 = πt − πc ;

2. The sum of the two discordant probabilities

ξ = π10 + π01 .

East accepts these two parameters as inputs at the design stage.

We next specify the test statistic to be used during the interim monitoring stage. Suppose we
intend to execute McNemar’s test a maximum of K times in a group sequential setting. Let
the cumulative data up to and including the j th interim look consist of N(j) matched pairs
arranged in the form of the following 2× 2 contingency table of counts:

Table 6.2: 2× 2 Contingency Table of Counts of Matched Pairs at Look j

Experimental Total
Control No Response Response Probability

No Response n00(j) n01(j) r0(j)

Response n10(j) n11(j) r1(j)

Total Probability c0(j) c1(j) N(j)

For a = 0, 1 and b = 0, 1 define

π̂ab(j) =
nab(j)

N(j)
(6.3)

Then the sequentially computed McNemar test statistic at look j is

Zj =
δ̂j

se(δ̂j)
(6.4)

where
δ̂j = π̂01(j)− π̂10(j) (6.5)
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and

se(δ̂j) =
√
[n00(j) + n11(j)][n01(j) + n10(j)] + 4n01(j)n10(j)

N(j)
√
N(j)

. (6.6)

Note that the standard error (6.6) is equal to

se(δ̂j) =

√
ξ̂j − δ̂2j√
N(j)

. (6.7)

The above statistic was defined in the non-sequential setting by Fleiss (1981, page 117). We
now show how to use East to design and monitor a clinical trial based on McNemar’s test.

6.2.1 Trial Design

Consider a trial in which we wish to determine whether a transdermal delivery system (TDS)
can be improved with a new adhesive. Subjects are to wear the old TDS (control) and new TDS
(experimental) in the same area of the body for one week each. A response is said to occur if
the TDS remains on for the entire one week observation period. From historical data, it is
known that control has a response rate of 85% (πc = 0.85). It is hoped that the new adhesive
will increase this to 95% (πt = 0.95). Furthermore, of the 15% of the subjects who did not
respond on the control, it is hoped that 87% will respond on the experimental system. That is,
π01 = 0.87× 0.15 = 0.13. Based on these data, we can fill in all the entries of Table 6.1 as
displayed in Table 6.2.

Table 6.3: McNemar Probabilities for the TDS Trial
Experimental Total

Control No Response Response Probability
No Response 0.02 0.13 0.15

Response 0.03 0.82 0.85

Total Probability 0.05 0.95 1

Although it is expected that the new adhesive will increase the adherence rate, the comparison
is posed as a two-sided testing problem, testing H0: πc = πt against H1: πc ̸= πt at the 0.05
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level. We wish to determine the sample size to have 90% power for the values displayed in
Table 6.3. To design this trial, click Design tab, then Single Sample on the Discrete group,
and then clickMcNemar’s Test for Matched Pairs.

Single-Look Design First, consider a study with no interim analyses, and 90% power for two
sided test at α = 0.05. Choose the design parameters as shown below. We first consider a
single-look design, so leave the default value for Number of Looks to 1. Enter 0.9 for Power.
As shown in Table 6.2, we must specify δ1 = πt − πc = 0.1 and ξ = π01 + π10 = 0.16.

Click Compute. The design Des1 is shown as a row in the Output Preview located in the lower

6.2 McNemar’s Test – 6.2.1 Trial Design 101



<<< Contents * Index >>>

Chapter 6: Binomial Superiority One-Sample

pane of this window. A total of 158 subjects is required to have 90% power.

You can select this design by clicking anywhere on the row in the Output Preview. Click on

icon to get the output summary displayed in the upper pane. In the Output Preview
toolbar, click the icon to save this design Des1 to workbook Wbk1 in the Library. If you
hover the cursor over Des1 in the Library, a tooltip will appear that summarizes the input
parameters of the design.

Five-Look Design Now consider the same design with a maximum of 5 looks, using the
default Lan-DeMets (O’Brien-Fleming) spending function. Create a new design by selecting

Des1 in the Library, and clicking icon on the Library toolbar. Change the Number of
Looks from 1 to 5, to generate a study with four interim looks and a final analysis. A new tab
Boundary Info will appear. Clicking on this tab will reveal the stopping boundary parameters.
By default, the Spacing of Looks is set to Equal, which means that the interim analyses will be
equally spaced in terms of the number of patients accrued between looks. The left side
contains details for the Efficacy boundary, and the right side for the Futility boundary. By
default, there is an efficacy boundary (to reject H0) selected, but no futility boundary (to reject
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H1). The Boundary Family specified is of the Spending Functions type. The default
Spending function is the Lan-DeMets (Lan & DeMets, 1983), with Parameter OF
(O’Brien-Fleming), which generates boundaries that are very similar, though not identical, to
the classical stopping boundaries of O’Brien and Fleming (1979). Technical details of these
stopping boundaries are available in Appendix ??.

Click Compute to generate output for Des2. With Des2 selected in the Output Preview, click
the icon to save Des2 to the Library. In the Library, select the nodes for both Des1 and

Des2, by holding the Ctrl key, and then click the icon. The upper pane will display the
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output summary of the two designs side-by-side:

There has been a slight inflation in the maximum sample size, from 158 to 162. However, the
expected sample size is 120 subjects if the alternative hypothesis of δ1 = 0.10 and ξ = 0.16

holds. The stopping boundary, spending function, and Power vs. Sample Size charts can all be
displayed by clicking on the appropriate icons from the Library toolbar.

6.2.2 Interim Monitoring

Consider interim monitoring of Des2. Select Des2 in the Library, and click icon from the
Library toolbar. Alternatively, right-click on Des2 and select Create IM Dashboard. A new IM
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worksheet will appear.

Suppose, that the results are to be analyzed after results are available for every 32 subjects.
After the first 32 subjects were enrolled, one subject responded on the control arm and did not
respond on the treatment arm; four subjects responded on the treatment arm but did not
respond on the control arm; 10 subjects did not respond on either treatment; 17 subjects
responded on both the arms. This information is sufficient to complete all the entries in
Table 6.3 and hence to evaluate the test statistic value.

Click icon to invoke the Test Statistic Calculator. In the box next to
Cumulative Sample Size enter 32. Enter the values in the table as shown below and click
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Recalc.

Clicking OK results in the following entry in the first look row.

As you can see the value of the test statistic, 1.342, is within the stopping boundaries,
(4.909,-4.909). Thus, the trial continues.

The second interim analysis was performed after data were available for 64 subjects. A total of
two subjects responded on the control arm and failed to respond on the treatment arm; seven
subjects responded on the treatment arm and failed to respond on the control arm; 20
subjects responded on neither arm; 35 subjects responded on both the arms.

Click on the second row in the table in the upper section. Then click icon.
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Enter the appropriate values in the table as shown below and click Recalc.

Then click OK. This results in the following screen.

At the third interim analysis, after 96 subjects were enrolled, a total of two subjects responded
on the control arm and failed to respond on the treatment arm; 13 subjects responded on the
treatment arm and failed to respond on the control arm; 32 subjects did not respond on either
arm; 49 subjects responded on both the arms.

Click on the third row in the table in the upper section. Then click icon.
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Enter the appropriate values in the table as shown below and click Recalc.

Then click OK. This results in the following message box.
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Clicking on Stop yields the following Interim Monitoring output.

We reject the null hypothesis that δ = 0, based on these data.

6.2.3 Simulation

Des2 can be simulated to examine the properties for different values of the parameters. First,
we verify the results under the alternative hypothesis at which the power is to be controlled,
namely δ1=0.10 and ξ=0.16.

Select Des2 in the Library, and click icon from Library toolbar. Alternatively, right-click
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on Des2 and select Simulate. A new Simulation worksheet will appear.

Click Simulate to start the simulation. Once the simulation run has completed, East will add an
additional row to the Output Preview labeled Sim1. Select Sim1 in the Output Preview. If

you click icon, you will see some of the simulation output details displayed in the upper
pane. Click icon to save it to the Library. Double-click on Sim1 in the Library. The
simulation output details will be displayed as shown below. The results confirm that the power

110 6.2 McNemar’s Test – 6.2.3 Simulation



<<< Contents * Index >>>

East
R⃝
6.4

c⃝ Cytel Inc. Copyright 2017

is at about 90%.

To confirm the results under the null hypothesis, set δ1 = 0 in the Response Generation Info
tab in the simulation worksheet and then click textbfSimulate. The results, which confirm that
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the type-1 error rate is approximately 5%, are given below.

While it is often difficult to specify the absolute difference of the discordant probabilities, δ1, it
is even more difficult to specify the sum of the discordant probabilities, ξ. Simulation can be
used to examine the effects of misspecification of ξ. Run the simulations again, now with
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δ1=0.10 and ξ=0.2. The results are given below.

Notice that this provides a power of approximately 81%. Larger values of ξ would further
decrease the power. However, values of ξ >0.2 with δ1=0.1 would be inconsistent with the
initial assumption of πc = 0.85 and πt=0.95. Additional simulations for various values of δ and
ξ can provide information regarding the consequences of misspecification of the input
parameters.
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7 Dose Escalation

This chapter deals with the design, simulation, and interim monitoring of Phase 1 oncology
trials. A brief overview of the designs is given below; more technical details are available in the
Appendix.

One of the primary goals of Phase I trials in oncology is to find the maximum tolerated dose
(MTD). Currently, the vast majority of such trials have employed traditional dose escalation
methods such as the 3+3 design. The 3+3 design starts by allocating three patients typically to
the lowest dose level, and then adaptively moves up and down in subsequent cohorts until
either the MTD is obtained, or the trial is stopped for excessive toxicity. In addition to the 3+3,
East also provides the Continual Reassessment Method (CRM), the modified Toxicity
Probability Interval (mTPI) method, and the Bayesian logistic regression model (BLRM).
Compared to the 3+3, these modern methods may offer a number of advantages, which can
be explored systematically via simulation and interim monitoring.

The CRM (Goodman et al., 1995; O’Quigley et al., 1990) is a Bayesian model-based method
that uses all available information from all doses to guide dose assignment. One first specifies
a target toxicity, a one-parameter dose response curve and corresponding prior distribution.
The posterior mean, and predictions for the probability of toxicity at each dose, is updated as
the trial progresses. The next recommended dose is the one whose toxicity probability is
closest to the target toxicity.

The mTPI method (Ji et al., 2010) is Bayesian like the CRM, but rule-based like the 3+3. In this
way, the mTPI represents a useful compromise between the other methods. An independent
beta distribution is assumed for the probability of toxicity at each dose. A set of decision
intervals are specified, and subsequent dosing decisions (up, down, or stay) are determined by
computing the normalized posterior probability in each interval at the current dose. The
normalized probability for each interval is known as the unit probability mass (UPM).
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A more advanced version of the CRM is the BLRM (Neuenschwander et al., 2008), which
assumes a two-parameter logistic dose response curve. In addition to a target toxicity, one
specifies a set of decision intervals and associated losses for guiding dosing decisions. As data
accumulate, the posterior expected loss (or Bayes risk), at each dose is calculated, and the next
recommended dose is the one with the lowest expected loss.

7.1 3+3
7.1.1 Simulation 7.1.2 Interim Monitoring

7.1.1 Simulation

Click Discrete: One Sample on the Design tab, and then click Dose Escalation Design: 3+3.

In the upper pane of this window is the Input dialog box, which is separated into three tabs:
Simulation Parameters, Response Generation Info, and Simulation Control Info. First, you
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may specify theMax. Number of Doses as 7.

In the Simulation Parameters tab, enter 30 as theMax. Sample Size. For the 3+3 design, the
Cohort Size is fixed at 3. For the Starting Dose, select the Lowest Dose.

There are two flavors of 3+3 offered: L and H. The key difference between the 3+3 H method
and 3+3 L method is: If we have observed 2 DLTs out of 6 patients at the current dose, the 3+3
H method will declare the current dose as MTD, while the 3+3 L method will recommend
de-escalation.

Select 3+3 H. The Decision Rules table gives a compact summary of the algorithm
implemented here.

In the Response Generation Info tab, you can specify a set of true dose response curves from
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which to simulate.

The grid on the right displays the set of dose response profiles from which East will simulate.
In the row titled Dose, you can specify the dose levels (e.g., in mg). In the row titled GC1, you
can edit the true probabilities of toxicity at each dose. You can also rename the profile by
directly editing that cell. For now, leave all entries at their default values.

There are two ways to add profiles. The first way involves copying an existing profile on the
right grid to the left grid. Select the row for GC1, and click the leftward pointing arrow to paste
the GC1 profile onto the left grid.

Edit the profile GC2 with the following probabilities (0.05, 0.15, 0.25, 0.35, 0.45, 0.55, 0.65), and
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click the rightward pointing arrow to add this profile to the right grid.

Select both rows GC1 and GC2 in the right grid, and click Plot Selected. The dose toxicity
curves will be plotted on the same chart.

The second way to add a new profile is to generate from a parametric curve family. For
example, click on the menu Curve Family and select Emax. You may construct a
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four-parameter Emax curve by adjusting its parameters as below.

You can click Plot to generate the dose toxicity curve for this single profile in the left grid. For
now, let us ignore the Emax curve, and continue with the two general curves.

In the Simulation Control Info tab, check the boxes corresponding to Save summary
statistics and Save subject-level data. These options will provides access to several charts
derived from these more detailed levels of simulated data. If you wish to display subject-level
plots for more than one simulation, you can increase the number. For now, leave this at 1 to
save computation time.
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Click Simulate. East will simulate data generated from the two profiles you specified, and
apply the 3+3 design to each simulation data set. Once completed, the two simulations will
appear as two rows in the Output Preview pane below.

Select both rows in the Output Preview and click the icon in the toolbar. The two
simulations will be displayed side by side in the Output Summary.

In the Output Preview toolbar, click the icon to save both simulations to the Library.

7.1 3+3 – 7.1.1 Simulation 121



<<< Contents * Index >>>

Chapter 7: Dose Escalation

Double-click Sim1 in the Library to display the simulation output details.

With Sim1 selected in the Library, click the Plots icon to access a wide range of available plots.

122 7.1 3+3 – 7.1.1 Simulation



<<< Contents * Index >>>

East
R⃝
6.4

c⃝ Cytel Inc. Copyright 2017

Below is an example of the MTD plot:

Close each plot after viewing, or save them by clicking Save in Workbook. To save your
simulations and charts to disk, right-click Wbk1 in the Library and then Save As....

Once you have saved the workbook, you may like to clean up your library by selecting Wbk1 in
the Library and clicking the Delete icon. The same action can be performed for Sim1 and Sim2

7.1 3+3 – 7.1.1 Simulation 123



<<< Contents * Index >>>

Chapter 7: Dose Escalation

in the Output Preview.

7.1.2 Interim Monitoring

Right-click one of the Simulation nodes with 3+3 in the Library, and select Interim
Monitoring. This will open an empty interim monitoring dashboard.

Click Enter Interim Data to open a window in which to enter data for the first cohort: in
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particular, the Dose Assigned and the DLTs Observed. Click OK to continue.

The dashboard will be updated accordingly, and the next Recommended Dose is 10.

Click Enter Interim Data again, with 10 selected as Dose Assigned, enter 2 for DLTs
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Observed, and click OK.

.

East now recommends de-escalation to 5.

Click Enter Interim Data, with 5 selected as Dose Assigned, enter 2 for DLTs Observed, and
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click OK.

.

East recommends that you stop the trial.

.
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Click Final Inference to generate a table for final inference.

.

7.2 Continual Reassessment Method (CRM)
7.2.1 Simulation 7.2.2 Interim Monitoring

7.2.1 Simulation

Click Discrete: One Sample on the Design tab, and then click Dose Escalation Design:
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Continual Reassessment Method.

In the upper pane of this window is the Input dialog box, which is separated into four tabs:
Simulation Parameters, Stopping Rules, Response Generation Info, and Simulation
Control Info.

In the Simulation Parameters tab, enter 30 as theMaximum Sample Size, and 3 for Cohort
Size. For the Starting Dose, select the Lowest Dose. If you were to check the box Start with
3+3 Design, then you would be simulating from the 3+3 design first, before switching to the
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CRM, either upon reaching the MTD, or upon observing the first DLT. For this tutorial,
however, leave the box unchecked.

Enter 0.25 for the Target Probability of Toxicity, and 0.3 for the Target Probability Upper
Limit. This will ensure that the next dose assignment is that whose toxicity probability is
closest to 0.25, and below 0.3.

If you were to click Additional Options..., a new window will appear, which provides two
options corresponding to the original CRM procedure: (1) Allow skipping of untried doses
while escalating, and (2) Allow dose escalation even if previous subject experienced DLT.

As was recommended in later variations of CRM, in the interests of promoting safety, leave
these two options unchecked. This means that no doses will be skipped while escalating, and
no dose escalation will occur when the most recent subject experienced a DLT.

ForModel Type, select Power, with a Gamma(α = 1,β = 1) prior for θ. Other model types
available include the Logistic and the Hyperbolic Tangent. Finally, for the prior
probabilities of toxicity of all doses (known as the skeleton), enter: 0.05, 0.1, 0.2, 0.3, 0.35, 0.4,
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and 0.45.

In the Stopping Rules tab, you may specify various rules for stopping the trial. Enter the
following inputs as below.

The Overdosing Rule states that if the posterior probability of overdosing (toxicity at the
lowest dose is greater than target toxicity) exceeds 0.8, then the trial will be stopped. The
Underdosing Rule states that if the posterior probability of underdosing (toxicity at the
highest dose is lower than target toxicity) exceeds 0.9, then the trial will be stopped. A
minimum of 6 subjects will need to be observed on a dose before either of these two rules is
activated. A further stopping rule is based on theMax. Allocation Rule: As soon as 9 subjects
are allocated to any single dose, the trial will be stopped.

In the Response Generation Info tab, you can specify a set of true dose response curves from
which to simulate. Leave the default profile as shown below. If you wish to edit or add
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additional profiles (dose response curves), see the corresponding section for the 3+3 design.

In the Simulation Control Info tab, check the boxes corresponding to Save summary

statistics and Save subject­level data. These options will provides access to
several charts derived from these more detailed levels of simulated data. If you wish to display
subject-level plots for more than one simulation, you can increase the number. For now, leave
this at 1 to save computation time.

Click Simulate to simulate the CRM design. In the Output Preview toolbar, click the
icon to save the simulation to the Library. Double-click the simulation node in the Library to
display the simulation output details. Click the Plots icon in the Library to access a wide range
of available plots.
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7.2.2 Interim Monitoring

Right-click the Simulation node with CRM in the Library, and select Interim Monitoring. This
will open an empty interim monitoring dashboard.

Click Enter Interim Data to open a window in which to enter data for the first cohort: in
particular, the Dose Assigned and the DLTs Observed. Click OK to continue.

Continue in this manner by clicking Enter Interim Data, entering the following doses, and the
corresponding number of DLTs: 0 DLTs at dose 10, 0 DLTs at dose 15, 1 DLT at dose 25, 1 DLT
at dose 40, 2 DLTs at dose 40, 1 DLT and dose 25, and finally 1 DLT at dose 25.
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After each cohort, East will update the Interim Monitoring Dashboard.

At this point, East recommends that you stop the trial.

.

Click Final Inference to generate a table for final inference.

.
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7.3 modified Toxicity Probability Interval (mTPI)
7.3.1 Simulation 7.3.2 Interim Monitoring

7.3.1 Simulation

Click Discrete: One Sample on the Design tab, and then click Dose Escalation Design:
Modified Toxicity Probability Interval.

In the upper pane of this window is the Input dialog box, which is separated into four tabs:
Simulation Parameters, Stopping Rules, Response Generation Info, and Simulation
Control Info.
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In the Simulation Parameters tab, enter 30 as theMaximum Sample Size, and 3 for Cohort
Size. For the Starting Dose, select the Lowest Dose. If you were to check the box Start with
3+3 Design, then you would be simulating from the 3+3 design first, before switching to the
mTPI, either upon reaching the MTD, or upon observing the first DLT. For this tutorial,
however, leave the box unchecked.

Enter 0.25 for the Target Probability of Toxicity, 0.2 for the upper limit of the Under dosing
interval, and 0.3 for the upper limit of Proper dosing interval.

These entries imply that toxicity probabilities within this interval [0.2 to 0.3] can be regarded as
equivalent to the target toxicity (0.25) as far as dosing decisions are concerned. Finally, we will
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assume a uniform Beta(a = 1, b = 1) prior distribution for all doses.

In the Stopping Rules tab, enter the following inputs as below.

For the mTPI design, the stopping rule is based on dose exclusion rules. This states that if
there is greater than a 0.95 posterior probability that toxicity for a given dose is greater than
the target toxicity, that dose and all higher doses will be excluded in subsequent cohorts.
When this dose exclusion rule applies to the lowest dose, then all doses are excluded, and
hence the trial will be stopped for excessive toxicity. Furthermore, the dose exclusion rule is
not activated until at least 3 subjects are observed on a dose.

In the Response Generation Info tab, you can specify a set of true dose response curves from
which to simulate. Leave the default profile as shown below. If you wish to edit or add
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additional profiles (dose response curves), see the corresponding section for the 3+3 design.

In the Simulation Control Info tab, check the boxes corresponding to Save summary
statistics and Save subject-level data. These options will provides access to several charts
derived from these more detailed levels of simulated data. If you wish to display subject-level
plots for more than one simulation, you can increase the number. For now, leave this at 1 to
save computation time.

Click Simulate to simulate the mTPI design. In the Output Preview toolbar, click the
icon to save the simulation to the Library. Double-click the simulation node in the Library to
display the simulation output details. Click the Plots icon in the Library to access a wide range
of available plots.
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7.3.2 Interim Monitoring

Right-click one of the Simulation nodes with mTPI in the Library, and select Interim
Monitoring. This will open an empty interim monitoring dashboard.

Click on Trial Monitoring Table to generate a table to guide dosing decisions for this trial.
For example, if the cumulative number of patients treated at the current dose is 8, and the
cumulative number of toxicities at this dose is 3, then the mTPI method recommends a Stay
decision. Close this table before continuing.

Click Enter Interim Data to open a window in which to enter data for the first cohort: in
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particular, the Dose Assigned and the DLTs Observed. Click OK to continue.

The dashboard will be updated accordingly. The decision for the next cohort is based on the
highest Unit Probability Mass (UPM): the posterior probability for each toxicity interval divided
by the length of the interval. The underdosing interval corresponds to an E (Escalate) decision,
the proper dosing interval corresponds to an S (Stay) decision, and the overdosing interval
corresponds to a D (De-escalate) decision. In this case, the UMP for underdosing is highest.

Thus, the recommendation is to escalate to dose 10.

Continue in this manner by entering data for each subsequent cohort, and observe how the
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interim monitoring dashboard updates. One example is given below.

Suppose we wished to end the study after 8 cohorts (24 patients). Click Final Inference to end
the study and generate a table of final inference. Here, the MTD is 15, while the fitted MTD is
13.269, estimated from the interpolated isotonic estimates.

7.4 Bayesian logistic regression model (BLRM)

7.4.1 Simulation

Click Discrete: One Sample on the Design tab, and then click Dose Escalation Design:
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Bayesian Logistic Regression Model.

In the upper pane of this window is the Input dialog box, which is separated into four tabs:
Simulation Parameters, Stopping Rules, Response Generation Info, and Simulation
Control Info.

In the Simulation Parameters tab, enter 30 as theMaximum Sample Size, and 3 for Cohort
Size. For the Starting Dose, select the Lowest Dose. If you were to check the box Start with
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3+3 Design, then you would be simulating from the 3+3 design first, before switching to the
BLRM, either upon reaching the MTD, or upon observing the first DLT. For this tutorial,
however, leave the box unchecked.

The next step is to choose a Dose Selection Method: either by Bayes Risk or by EWOC. For
the next cohort, the Bayes risk method selects the dose that minimizes the posterior expected
loss, aka Bayes risk. In contrast, the escalation with overdose control (EWOC) method selects
the dose that maximizes the posterior probability of targeted toxicity, for all doses where the
posterior probability of overdosing (either excessive or unacceptable toxicity) is less than the
user-specified threshold. In this example, we will use the EWOC method.

A bivariate normal distribution with corresponding means, variances, and correlation, can be
specified for the ln(α) and ln(β) parameters of the two-parameter logistic.

Click Posterior Sampling Methods to select from one of two methods: Metropolis Hastings,
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or direct Monte Carlo. For this tutorial, click OK to select Metropolis Hastings.

In the Stopping Rules tab, you can specify up to two rules for stopping the trial. Check the
appropriate boxes and enter values as below.

The Target Rule will stop the trial when the posterior probability of being in the Target toxicity
interval exceeds 0.8. A minimum of 6 subjects should be observed before this rule is activated.
TheMax. Allocation Rule will stop the trial if at least 12 subjects are allocated to any dose.

In the Response Generation Info tab, you can specify a set of true dose response curves from
which to simulate. Leave the default profile as shown below. If you wish to edit or add
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additional profiles (dose response curves), see the corresponding section for the 3+3 design.

In the Simulation Control Info tab, check the boxes corresponding to Save summary
statistics, Save subject-level data, and Save final posterior samples. These options will
provides access to several charts derived from these more detailed levels of simulated data. If
you wish to display subject-level plots, or posterior distribution plots, for more than one
simulation, you can increase the number. For now, leave both of these at 1 to save
computation time.

Click Simulate to simulate the BLRM design. In the Output Preview toolbar, click the
icon to save the simulation to the Library. Double-click the simulation node in the Library to
display the simulation output details. Click the Plots icon in the Library to access a wide range
of available plots.
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7.4.2 Interim Monitoring

Right-click the Simulation node with BLRM in the Library, and select Interim Monitoring. This
will open an empty interim monitoring dashboard.

Click Enter Interim Data to open a window in which to enter data for the first cohort: in
particular, the Dose Assigned and the DLTs Observed. Click OK to continue.

The dashboard will be updated accordingly. The decision for the next cohort is based on the
dose with the highest posterior probability of targeted toxicity, with less than the
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user-specified threshold (0.25) probability of overdosing. In this case, this is dose 15.

Continue in this manner by entering data for each subsequent cohort, and observe how the
interim monitoring dashboard updates. One example is given below.

At this point, East will display the following message:

Click OK to continue, and then click Final Inference Interim Monitoring toolbar. The following
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Dose 25 happens to have the highest posterior probability of being in the target toxicity
interval, with little probability of being in the overdosing (excessive or unacceptable) intervals.

TheModel Fit plot has also been updated. One curve is the two-parameter logistic function
described by plug-in (posterior mean) estimates. The other curve interpolates between the
posterior mean of the toxicity probability at each dose. In both cases, the target probability lies
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quite close to the predicted toxicity probability at dose 25, with the fitted MTD at around 30.
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8 Count Data One-Sample

This chapter deals with the design of tests involving count or Poisson response rates. Here,
independent outcomes or events under examination can be counted in terms of whole
numbers, and typically are considered rare. In other words, a basic assumption of the Poisson
distribution is that the probability of an event occurring is proportional to the length of time
under consideration. The longer the time interval, the more likely the event will occur.
Therefore, in this context interest lies in the rate of occurrence of a particular event during a
specified period. Section 8.1 focuses on designs in which an observed Poisson response rate is
compared to a fixed response rate, possibly derived from historical data.

8.1 Single Poisson Rate

Data following a Poisson distribution are non-negative integers, and the probability that an
outcome occurs exactly k times can be calculated as:

P (k) =
e−λλk

k!
, k = 0, 1, 2, . . . where λ is the average rate of occurrence.

When comparing a new protocol or treatment to a well-established control, a preliminary
single-sample study may result in valuable information prior to a full-scale investigation. In
experimental situations it may be of interest to determine whether the response rate λ differs
from a fixed value λ0. Specifically we wish to test the null hypothesis H0: λ = λ0 against the
two sided alternative hypothesis H1: λ ̸= λ0 or against one sided alternatives of the form
H1: λ > λ0 or H1: λ < λ0. The sample size, or power, is determined for a specified value of λ
which is consistent with the alternative hypothesis, denoted λ1.
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8.1.1 Trial Design

Consider the design of a single-arm clinical trial in which we wish to determine if the positive
response rate of a new acute pain therapy is at least 30% per single treatment cycle. Thus, it is
desired to test the null hypothesis H0: λ = 0.2 against the one-sided alternative hypothesis
H1: λ ≥ 0.3. The trial will be designed such that a one sided α = 0.05 test achieves 80% power
at λ = λ1 = 0.3.

In the Design tab under the Count group choose One Sample and then Single Poisson Rate.

This will launch the following input window:

Enter the following design parameters:

Test Type: 1 sided
Type 1 Error (α): 0.05
Power: 0.8
Sample Size (n): Computed (select radio button)
Rate under Null (λ0): 0.2
Rate under Alt. (λ1): 0.3
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Follow-up Time (D): 1

Click Compute. The design is shown as a row in the Output Preview window:

The sample size required in order to achieve the desired 80% power is 194 subjects. As is
standard in East, this design has the default name Des 1. To see a summary of the output of

this design, click anywhere in the row and then click the icon in the Output Preview
toolbar. The design details will be displayed in the upper pane, labeled Output Summary.

In the Output Preview toolbar, click icon to save this design Des1 to workbookWbk1
in the Library. An alternative method to view design details is to hover the cursor over the
node Des1 in the Library. A tooltip will appear that summarizes the input parameters of the
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design.

With the design Des1 selected in the Library, click icon on the Library toolbar, and then
click Power vs. Sample Size. The power curve for this design will be displayed. You can save
this chart to the Library by clicking Save inWorkbook. Alternatively, you can export the chart
in one of several image formats (e.g., Bitmap or JPEG) by clicking Save As... or Export into a
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PowerPoint presentation.

Close the Power vs. Sample Size chart. To view a summary of all characteristics of this design,

select Des1 in the Library, and click icon.

In addition to the Power vs. Sample size chart and table, East also provides the efficacy
boundary in the Stopping Boundaries chart and table.
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Alternatively, East allows the computation of either the Type-1 error (α) or Power for a given
sample size. Using the Design Input/Output window as described above, simply enter the
desired sample size and click Compute to calculate the resulting power of the test.
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Often in experiments based on count data, the aim is to compare independent samples from
two populations in terms of the rate of occurrence of a particular outcome. In medical
research, outcomes such as the number of times a patient responds to a therapy, develops a
certain side effect, or requires specialized care, are of interest. Or perhaps a therapy is being
evaluated to determine the number of times it must be applied until an acceptable response
rate is observed. East supports the design of clinical trials in which this comparison is based on
the ratio of rates, assuming a Poisson or Negative Binomial distribution. These two cases are
presented in Sections 9.1 and 9.2, respectively.

9.1 Poisson - Ratio of Rates
9.1.1 Trial Design

Let λc and λt denote the Poisson rates for the control and treatment arms, respectively, and let
ρ1 = λt/λc. We want to test the null hypothesis that ρ1 = 1 against one or two-sided
alternatives. The sample size, or power, is determined to be consistent with the alternative
hypothesis, that is H1 : λt ̸= λc, H1 : λt > λc, or H1 : λt < λc.

9.1.1 Trial Design

Suppose investigators are preparing design objectives for a prospective randomized trial of a
standard treatment (control arm) vs. a new combination of medications (therapy arm) to
present at a clinical trials workshop. The endpoint of interest is the number of abnormal ECGs
(electrocardiogram) within seven days. The investigators were interested in comparing the
therapy arm to the control arm with a two sided test conducted at the 0.025 level of
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significance. It can be assumed that the rate of abnormal ECGs in the control arm is 30%, thus
λt = λc = 0.3 under H0. The investigators wish to determine the sample size to attain power
of 80% if there is a 25% decline in the event rate, that is λt/λc = 0.75. It is important to note
that the power of the test depends on λc and λt, not just the ratio, so different values of the
pair (λc , λt) with the same ratio will yield different solutions.

We will now design a study that compares the control arm to the combination therapy arm. In
the Design tab under the Count group choose Two Samples and then Poisson - Ratio of
Rates.

This will launch the following input window:

Enter the following design parameters:
Test Type: 2-sided
Type 1 Error (α): 0.05
Power: 0.8
Sample Size (n): Computed (select radio button)
Allocation Ratio (nt/nc): 1
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Rate for Control (λc): 0.3
Rate for Treatment (λt): 0.225 (will be automatically calculated)
Ratio of Rates ρ1 = (λt/λc): 0.75
Follow-up Control (Dc): 7
Follow-up Treatment (Dt): 7

The Allocation Ratio (nt : nc) describes the ratio of patients to each arm. For example, an
allocation ratio of 3:1 indicates that 75% of the patients are randomized to the treatment arm
as opposed to 25% to the control. Here we assume the same number of patients in both arms.
Click Compute. The design is shown as a row in the Output Preview window:

The sample size required in order to achieve the desired 80% power is 211 subjects. As is
standard in East, this design has the default name Des 1. To see a summary of the output of

this design, click anywhere in the row and then click the icon in the Output Preview
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toolbar. The design details will be displayed in the upper pane, labeled Output Summary.

In the Output Preview toolbar, click icon to save this design Des1 to workbookWbk1
in the Library. An alternative method to view design details is to hover the cursor over the
node Des1 in the Library. A tooltip will appear that summarizes the input parameters of the
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design.

With the design Des1 selected in the Library, click icon on the Library toolbar, and then
click Power vs. Sample Size. The power curve for this design will be displayed. You can save
this chart to the Library by clicking Save inWorkbook. Alternatively, you can export the chart
in one of several image formats (e.g., Bitmap or JPEG) by clicking Save As... or Export into a
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PowerPoint presentation.

Close the Power vs. Sample Size chart. To view all computed characteristics of this design,
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select Des1 in the Library, and click icon.

In addition to the Power vs. Sample size chart and table, East also provides the efficacy
boundary in the Stopping Boundaries chart and table.

Alternatively, East allows the computation of either the Type-1 error (α) or Power for a given
sample size. Using the Design Input Output window as described above, simply enter the
desired sample size and click Compute to calculate the resulting power of the test.

9.2 Negative Binomial Ratio of Rates

In experiments where the data follows a binomial distribution, the number of successful
outcomes for a fixed number of trials is of importance when determining the sample size to
adequately power a study. Suppose instead that it is of interest to observe a fixed number of
successful outcomes (or failures), but the overall number of trials necessary to achieve this is
unknown. In this case, the data is said to follow a Negative Binomial Distribution. There are
two underlying parameters of interest. As with the Poisson distribution, λ denotes the average
rate of response for a given outcome. In addition, a shape parameter γ specifies the desired
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number of observed ”successes”. As with the Poisson distribution, the Negative Binomial
distribution can be useful when designing a trial where one must wait for a particular event.
Here, we are waiting for a specific number of successful outcomes to occur. A Poisson
regression analysis assumes a common rate of events for all subjects within a stratum, as well
as equal mean and variance (equidispersion). With over dispersed count data, estimates of
standard error from these models can be invalid, leading to difficulties in planning a clinical
trial. Increased variability resulting from over dispersed data requires a larger sample size in
order to maintain power. To address this issue of allowing variability between patients, East
provides valid sample size and power calculations for count data using a negative binomial
model, resulting in a better evaluation of study design and increased likelihood of trial success.

9.2.1 Trial Design

Suppose that a hypothetical manufacturer of robotic prostheses, those that require several
components to fully function, has an order to produce a large quantity of artificial limbs.
According to historical data, about 20% of the current limbs fail the rigorous quality control
test and therefore cannot be shipped to patients. For each order, the manufacturer must
produce more than requested; in fact they must continue to produce the limbs until the
desired quantity passes quality control. Given that there is a high cost in producing these
prosthetic limbs, it is of great interest reduce the number of those that fail the test.

The company plans to introduce a new feature to the current model, the goal being the
probability of failure is reduced to 10%. It is safe to assume that the enhancement will not
cause a decline in the original success rate. In this scenario, we wish to test the null hypothesis
H0: λc = λt = 0.2 against the one sided alternative of the form H1: λc > λt. Quality control
investigators wish to conduct a one-sided test at the α = 0.05 significance level to determine
the sample size required obtain 90% power to observe a 50% decline in the event rate, i.e.
λt/λc = 0.5. It is important to note that the power of the test depends on λc and λt, not just
the ratio, so different values of the pair (λc , λt) with the same ratio will have different
solutions. The same holds true for the shape parameter. Different values of (γc , γt) will result
in different sample sizes or power calculations. East allows user specific shape parameters for
both the treatment and control groups, however for this example assume that the desired
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number of successful outcomes for both groups is 10.

The following illustrates the design of a two-arm study comparing the control arm, which the
current model of the prosthesis, to the treatment arm, which is the enhanced model. In the
Design tab under the Count group choose Two Samples and then Negative Binomial -
Ratio of Rates.

This will launch the following input window:

Enter the following design parameters:

Test Type: 1 sided
Type 1 Error (α): 0.05
Power: 0.9
Sample Size (n): Computed (select radio button)
Allocation Ratio (nt/nc): 1
Rate for Control (λc): 0.2
Rate for Treatment (λt): 0.1

9.2 Negative Binomial Ratio of Rates – 9.2.1 Trial Design 167



<<< Contents * Index >>>

Chapter 9: Count Data Two-Samples

Ratio of Rates ρ = (λt/λc): 0.5
Follow-up Time (D): 1
Shape Control (γc): 10
Shape Treatment (γt): 10

The Allocation Ratio (nt : nc) describes the ratio of patients to each arm. For example, an
allocation ratio of 3:1 indicates that 75% of the patients are randomized to the treatment arm
as opposed to 25% to the control. Here we assume the same number of patients in both arms.
Click Compute. The design is shown as a row in the Output Preview window:

The sample size required in order to achieve the desired 90% power is 1248 subjects. As is
standard in East, this design has the default name Des 1. To see a summary of the output of

this design, click anywhere in the row and then click the icon in the Output Preview
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toolbar. The design details will be displayed in the upper pane, labeled Output Summary.

In the Output Preview toolbar, click icon to save this design Des1 to workbookWbk1
in the Library. An alternative method to view design details is to hover the cursor over the
node Des1 in the Library. A tooltip will appear that summarizes the input parameters of the
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design.

With the design Des1 selected in the Library, click icon on the Library toolbar, and then
click Power vs. Sample Size. The power curve for this design will be displayed. You can save
this chart to the Library by clicking Save inWorkbook. Alternatively, you can export the chart
in one of several image formats (e.g., Bitmap or JPEG) by clicking Save As... or Export into a
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PowerPoint presentation.

Close the Power vs. Sample Size chart. To view all computed characteristics of this design,
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select Des1 in the Library, and click icon.

In addition to the Power vs. Sample size chart and table, East also provides the efficacy
boundary in the Stopping Boundaries chart and table.

For a specific desired sample size, East allows the computation of either the Type-1 error (α)
or Power for a test. Using the Design Input Output window and methods as described
above, simply enter the desired sample size and click Compute to calculate the resulting
power of the test.

In addition to this example, consider the following illustration of the benefit of using the
negative binomial model in clinical trials. In real life settings, the variance of count data
observed between patients is typically higher than the observed mean. The negative binomial
model accommodates between subject heterogeneity according to a Gamma distribution. For
example:

Poisson: Y ∼ Poisson(λ)

Negative Binomial: Yi ∼ Poisson(λki) where ki ∼ Gamma(k)

172 9.2 Negative Binomial Ratio of Rates – 9.2.1 Trial Design



<<< Contents * Index >>>

East
R⃝
6.4

c⃝ Cytel Inc. Copyright 2017

In the case of no overdispersion (k = 0) the negative binomial model reduces to the Poisson
model. In the figure below, the Poisson and negative binomial models are displayed under
various values of the dispersion parameter.

Assuming the above parameterization, the variance of the negative binomial model is λ+ kλ2.
The inflation in variance is thus linear by the factor 1 + k ∗ λ and dependent on the mean.
Depending on the distributional assumption used and its impact on the variance, sample size
and power can vary widely.

In multiple sclerosis (MS) patients, magnetic resonance imaging (MRI) is used as a marker of
efficacy by means of serial counts of lesions appearing on the brain. Exacerbations rates as a
primary endpoint are frequently used in MS as well as in chronic obstructive pulmonary
disease (COPD) and asthma (Keene et al. 2007). Poisson regression could be considered,
however this model would not address variability between patients, resulting in over
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dispersion. The negative binomial model offers an alternative approach.

TRISTAN (Keene et al. 2007) was a double-blind, randomized study for COPD comparing the
effects of the salmeterol/fluticasone propionate combination product (SFC) to salmeterol
alone, fluticasone proprionate alone and placebo. Although the primary end-point was
pre-bronchodilator FEV1, the number of exacerbations was an important secondary endpoint.

Suppose we are to design a new trial to be observed over a period of 1 to 2 years. The primary
objective is the reduction of the rate of exacerbations, defined as a worsening of COPD
symptoms that require treatment with antibiotics, cortisone or both, with the combination
product SFC versus placebo. Based on the TRISTAN results, we aim to reduce the incidence of
events by 33%. Suppose the exacerbation rate is 1.5 per year, and can expect to detect a rate
of 1.0 in the combination group. Assume a 2-sided test with a 5% significance level and 90%

power. Using a Poisson model, a total of 214 patients are needed to be enrolled in the study.

For the TRISTAN data, the estimate of the overdispersion parameter was 0.46 (95% CI:
0.34-0.60). Using a negative binomial model with overdispersion of 0.33, 0.66, 1 and 2, the
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increase in sample size ranged from 299 to 726, respectively.

Exacerbation rates are calculated as number of exacerbations divided by the length of time in
treatment in years. EAST can be used to illustrate the impact of a one versus two year study by
changing the follow-up duration.

Using a shape parameter of 0.66 for 382 patients, power is increased from 90% to 97% when
follow-up time is doubled (see below). Alternatively, 277 patients observed for two years
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would results in 90% power, which is the same as with 382 patients observed one year.

Negative binomial models are increasing in popularity for medical research, and as the
industry standard for trial design, East continues to evolve by incorporating sample size
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Reference: Oliver N. Keene, Mark R. K. Jones, Peter W. Lane, Julie Anderson (2007). Analysis of
exacerbation rates in asthma and chronic obstructive pulmonary disease: example from the
TRISTAN study. Pharmaceutical statistics, 6, 89-97
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10 Tutorial: Survival Endpoint

This tutorial introduces you to East 6, using examples for designing a clinical trial to compare
survival in two groups. It is suggested that you go through the tutorial while you are at the
computer, with East 6 running in it.

10.1 A Quick Feel of the Software

When you open East 6, the screen will look as shown below.

This is the Welcome screen of East 6 which enables us to open the tutorial file, select any
design and open any existing workbook. Close this screen by clicking the Cancel button.

In the tabs bar at the top of the ribbon, Design tab is already selected. Each tab has its own
ribbon. All the commands buttons under Design tab are displayed in its ribbon, with
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suggestive icons. These commands have been grouped under the categories of Continuous,
Discrete, Count, Survival and General. For this tutorial, let us explore the command Two
Samples under Survival category. In East, we use the terms ’time to event’ and ’survival’
interchangeably. Click on Two Samples. You will see a list of action items, which are dialog
box launchers.

Click on Logrank Test Given Accrual Duration and Study Duration. You will get the
following dialog box in the work area.

This dialog box is for computing Sample Size (n) and Number of Events. All the default input
specifications under the tab Design Parameters are on display: Design Type=Superiority,
Number of Looks=1, Test Type=1-Sided, Type-1 Error (α)=0.025, Power (1-β)=0.9, Allocation
Ratio (nt/nc)=1, # of Hazard Pieces=1, Input Method=Hazard Rates, Hazard Ratio (λt/λc)=0.5,
Log Hazard Ratio ln(λt/λc)=-0.693, Hazard Rate (Control)=0.0347, Hazard Rate
(Treatment)=0.0173, and Variance of Log-Hazard Ratio=Null. There are two radio buttons in
this dialog box, one at the side of Power (1-β) box and the second at the side of the combined
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boxes for Sample Size (n) and Number of Events. By default, the latter radio button is selected
indicating that the items against this radio button are to be computed using all other inputs.
Similarly, if the first radio button is selected, then Power will be computed using all other
inputs.

Now click on the tab Accrual/Dropout and you will see the following dialog box.

The default specifications in this dialog box are: Subjects are followed=Until End of Study,
Accrual Duration=22, Study Duration=38, # of Accrual Periods=1, and no Dropouts. Now
accept all the default specifications that are displayed for this single look design and be ready
to compute the Sample Size (n) and the Number of Events for the design. Click Compute.

At the end of the computation, you will see the results appearing at the bottom of the screen,
in the Output Preview pane, as shown below.

This single row of output preview contains relevant details of all the inputs and the computed
results for events and accruals. The maximum value for events is 88 and the committed accrual
is 182 subjects. Since this is a fixed-look design, the expected events are same as the

maximum required. Click anywhere in this row, and then click on the icon to get a
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detailed display in the upper pane of the screen as shown below.

The contents of this output, displayed in the upper pane, are the same as what is contained in
the output preview row for Design1 shown in the lower pane, but the upper pane display is
easier to read and comprehend. The title of the upper pane display is Output Summary. This
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is because, you can choose more than one design in the Output Preview pane and the display
in the upper pane will show the details of all the selected designs in juxtaposed columns.

The discussion so far gives you a quick feel of the software for computing the required events
and sample size for a single look survival design. We have not discussed about all the icons in
the output preview pane or the library pane or the hidden Help pane in the screen. We will
describe them taking an example for a group sequential design in the next section.

10.2 Group Sequential Design for a Survival Superiority Trial
10.2.1 Background Information on the study 10.2.2 Creating the design in East 10.2.3 Design Outputs
10.2.4 East icons explained 10.2.5 Saving created designs 10.2.6 Displaying Detailed Output
10.2.7 Comparing Multiple Designs 10.2.8 Events vs. Time plot 10.2.9 Simulation
10.2.10 Interim Monitoring

10.2.1 Background Information on the study

The randomized aldactone evaluation study (RALES) was a double-blind multicenter clinical
trial of aldeosterone-recepter blocker vs. placebo published in New England Journal of
Medicine (vol 341, 10, pages 709-717, 1999). This trial was open to patients with severe heart
failure due to systolic left ventricular dysfunction. The Primary endpoint was all-causes
mortality. The anticipated accrual rate was 960 patients/year. The mortality rate for the
placebo group was 38%. The investigators wanted 90% power to detect a 17% reduction in
the mortality hazard rate for the Aldactone group (from 0.38 to 0.3154) with α = 0.05, 2-sided
test. Six DMC meetings were planned. The dropout rate in both the groups is expected to be
5% each year. The patient accrual period is planned to be 1.7 years and the total study
duration to be 6 years.

10.2.2 Creating the design in East

For our purpose, let us create our own design from the basic details of this study. Now start
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afresh East. On the Design tab, click on Two Samples under Survival category. You will see a
list of action items, which are dialog box launchers.

Click on the second option Logrank Test Given Accrual Duration and Study Duration. You
will get the following dialog box in the work area.

All the specifications you see in this dialog box are default values, which you will have to
modify for the study under consideration.

Now, let the Design Type be Superiority.

Next, enter 6 in the Number of Looks box. You can see the range of choices for the number of
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looks is from 1 to 20.

Immediately after this selection, you will see a new tab Boundary Info added to the input
dialog box. We will look into this tab, after you complete the filling of current tab Design
Parameters.

Next, choose 2-Sided in the Test Type box.

Next, enter 0.05 in the Type-1 Error (α) box, and 0.9 in the Power box.

Next enter the specifications for survival parameters. Keep # of Hazard Pieces as 1. Click on
the check box against Hazard Ratio and choose Hazard Rates as the Input Method. Enter 0.83
as the Hazard Ratio and 0.38 as the Hazard Rate (Control). East computes and displays the
Hazard Rate (Treatment) as 0.3154. Keep the default choice of Null for Variance of Log-Hazard
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Ratio. Now the dialog box will look as shown below.

Next click the tab Accrual/Dropout Info. Keep the specification ‘Until End of Study’ for
Subjects are followed. Enter 1.7 as Accrual Duration and 6 as Study Duration. Keep # of
Accrual Periods as 1. Change the # of Pieces for dropouts to 1. Choose ’Prob. of Dropout’ as
the Input Method for entering information on dropouts. Enter 0.05 as probability of dropout
at end of 1 year for both the groups. Now the dialog box will appear as shown below.

Now click on the Boundary Info tab. In the dialog box of this tab, you can specify stopping
boundaries for efficacy or futility or both. For this trial, let us consider only Efficacy boundaries
only. Choose ’Spending Functions’ as the Efficacy Boundary Family.
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Choose ’Lan-DeMets’ in the Spending Function box.

Choose ’OF’ in the Parameter box.

Next, click the radio button near ’Equal’ for Spacing of Looks.

Choose ’Z Scale’ in the Efficacy Boundary Scale box.

In the table below of look-wise details, the columns - Info Fraction, Cumulative Alpha Spent,
and the upper and lower efficacy boundaries are computed and displayed as shown here.
Scroll a little bit to see the sixth look details.

The two icons and represent buttons for Error Spending Function chart and
Stopping Boundaries chart respectively. Click these two buttons one by one to see the
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following charts.
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10.2.3 Design Outputs

Now you have completed specifying all the inputs required for a group sequential trial design
and you are ready to compute the required events and sample size or accruals for the trial.
Click on the Compute button. After the computation is over, East will show in the Output
Preview pane the following results:

This single row of output preview contains relevant details of all the inputs and the computed
results for events and accruals. The maximum required Events is computed as 1243 and the
Committed Accrual to be 1646 subjects. The expected Events under H0 and H1 are estimated
to be 1234 and 904 respectively. The expected Study Duration under H0 and H1 are 5.354 and
3.725 respectively.

Click anywhere in this Output Preview row and then click on icon to get a summary in
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the upper pane of the screen as shown below.

10.2.4 East icons explained
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In the ’Output Preview’ pane, you see the following icons in the upper row.

The functions of the above icons are as indicated below. The tooltips also will indicate their
functions.

Output Summary(The output summary of selected design(s) will appear in the upper
pane)

Edit Design (The input dialog box of a selected design will appear in the upper pane)
Save in Workbook (Save one or more selected designs in a workbook)

Delete (Delete one or more selected designs)

Rename (Rename Design names)

Print (Print selected designs)

Display Precision (Local Settings)

Filter (Filter and select designs according to specified conditions)

Show/Hide Columns (Show/Hide Columns of the designs in the Output Preview panel)
The following icons can be seen at the right end of Output Preview pane and Output Summary
or Input/Output window respectively. Their functions are:

Maximize Output Preview Pane
Minimize Output Preview Pane

You may also notice a row of icons at the top of Output Summary window as shown below.
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The first icon is for Plot (Plots of a selected design will appear in a pop-up window).

The second icon is for Show Tables (The data for different plots can be displayed in tabular
form in pop-up windows).

If you have multiple designs in the output summary window, the third icon becomes active
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and can be used to move the order of those columns in the Output Summary.

The fourth icon is to print the Output Summary window.

As an example, if you click Power vs. Sample Size under Plot icon, you will get the following
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chart.

If you want to see the data underlying the above chart, click Show Table icon and click Power
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vs. Sample Size. You will see the following table in a pop-up window.

You can customize the format of the above table and also save it as case data in a workbook.
You may experiment with all the above icon / buttons to understand their functions.

10.2.5 Saving created Designs in the library and hard disk

In the Output Preview pane, select one or more design rows and click the icon,

The selected design(s) will then get added as a node(s) in the current workbook, as shown
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below.

The above action only adds the design to the workbook node in the library and it is not saved
in the hard disk. For saving in the hard disk, you may either save the entire workbook or only
the design by right-clicking on the desired item and choosing save or save as options.

Here in the library also, you see rows of icons.

Some of these icons you have already seen. The functions of other icons are:

Details (Details of a selected design will appear on the upper pane in the work area)

Output Settings (Output Settings can be changed here)

Simulate (Start the simulation process for any selected design node)

Interim Monitoring (Start the Interim Monitoring process for any selected design)

10.2.6 Displaying Detailed Output

Select the design from the Library and click the icon or Right-click on the Des1 node in
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the library and click Details.
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You will see the detailed output of the design displayed in the Work area.
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10.2.7 Comparing Multiple Designs

Click on Des1 row and then click Edit icon . You will get the input dialog box in the upper
pane. Change the Power value to 0.8 and then click Compute.
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You will see now Des2 is created and a row added to Output Preview pane as shown below.

Click on Des1 row and then keeping Ctrl key pressed, click on Des2 row. Now both the rows

will be selected. Next, click the Output Summary icon .

Now you will see the output details of these two designs displayed in the upper pane
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Compare Designs in juxtaposed columns, as shown below.

In a similar way, East allows the user to easily create multiple designs by specifying a range of
values for certain parameters in the design window. For example, in a survival trial the Logrank
Test given Accrual Duration and Study Duration design allows the input of multiple key
parameters at once to simultaneously create a number of different designs. For example,
suppose in a multi-look study the user wants to generate designs for all combinations of the
following parameter values: Power = 0.8 and 0.9, and Hazard Ratio - Alternative = 0.6, 0.7,
0.8 and 0.9. The number of combinations is 2 x 4 = 8. East creates all permutations using only a

10.2 Group Seq. Design – 10.2.7 Comparing Multiple Designs 203



<<< Contents * Index >>>

Chapter 10: Tutorial: Survival Endpoint

single specification under the Design Parameters tab in the design window. As shown below,
the values for Power are entered as a list of comma separated values, while the alternative
hazard ratios are entered as a colon separated range of values, 0.6 to 0.9 in steps of 0.1.

East computes all 8 designs and displays them in the Output Preview window:

East provides the capability to analyze multiple designs in ways that make comparisons
between the designs visually simple and efficient. To illustrate this, a selection of a few of the
above designs can be viewed simultaneously in both the Output Summary section as well as
in the various tables and plots. The following is a subsection of the designs computed from
the above example with differing values for number of looks, power and hazard ratio. Designs
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are displayed side by side, allowing details to be easily compared:

In addition East allows multiple designs to be viewed simultaneously either graphically or in
tabular format: Notice that all the four designs in the Output Summary window are selected.
Following figures compare these four designs in different formats.
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Stopping Boundaries (table)

Expected Sample Size (table)
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Power vs. Sample Size (plot)

Sample Size / Events vs. Time (plot)
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This capability allows the user to explore a greater space of possibilities when determining the
best choice of study design.

10.2.8 Events vs. Time plot

For survival studies, East provides a variety of charts and plots to visually validate and analyze
the design. For example, the Sample Size / Events vs. Time plot allows the user to see the
rate of increase in the number of events (control and treatment) over time (accrual duration,
study duration). An additional feature of this particular chart is that a user can easily update
key input parameters to determine how multiple different scenarios can directly impact a
study. This provides significant benefits during the design phase, as the user can quickly
examine how a variety of input values affect a study before the potentially lengthy task of
simulation is employed.

To illustrate this feature what follows is the example from the RALES study. For study details,
refer to subsection Background Information on the study of this tutorial.

Currently there are ten designs in the Output Preview area. Select Des1 from them and save it
to the current workbook. You may delete the remaining ones at this point.

To view the Sample Size / Events vs. Time plot, select the corresponding node in the Library
and under the Charts icon choose Sample Size / Events vs. Time:
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Survival parameters for this design can be edited directly through this chart by clicking the
Modify button. TheModify Survival Design window is then displayed for the user to update
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design parameters:

To illustrate the benefit of the modification feature, suppose at design time there is potential
flexibility in the accrual and duration times for the study. To see how this may affect the
number of subsequent events, modify the design to change the Accrual Duration to 3 and
Study Duration to 4. Re-create the plot to view the effect of these new values on the shape
and magnitude of the curves by clicking OK:
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Similar steps can be taken to observe the effect of changing other parameter values on the
number of events necessary to adequately power a study.
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10.2.9 Simulation

In the library, right-click on the node Des1 and click Simulate. You will be presented with the
following Simulation sheet.

This sheet has four tabs - Simulation Parameters, Response Generation Info, Accrual/Dropout
Info, and Simulation Control Info. Additionally, you can click Include Options and add some
more tabs like Randomization Info or Stratification Info tab and so on. The first three tabs
essentially contain the details of the parameters of the design. In the Simulation Control Info
tab, you can specify the number of simulations to carry out and specify the file for storing
simulation data. Let us first carry out 1000 simulations to check whether the design can reach
the specified power of 90%. The Response Generation Info tab, by default, shows the hazard
rates for control and treatment. We will use these values in our simulation.
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In the Simulation Control tab, specify the number of simulations as 1000.

Let us keep the values in other tabs as they are and click Simulate. The progress of simulation
process will appear in a temporary window as shown below.

This is the intermediate window showing the complete picture of simulations. Close this
window after viewing it. You can see the complete simulation output in the details view. A new
row, with the ID as Sim1, will be added in Output Preview.

Click on Sim1 row and click the Output Summary icon . You will see Simulation Output
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summary appearing in the upper pane. It shows that the simulated power as 0.90, indicating
that in 900 out of 1000 simulations the boundary was crossed.

You can save Sim1 as a node in the workbook. If you right-click on this node and then click
Details, you will see the complete details of simulation appearing in the work area. Here is a
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part of it.

10.2.10 Interim Monitoring

Click Des1 node under workbook wbk1 and click the icon. Alternatively, you can
right-click the Des1 node and select the item Interim Monitoring. In either case, you will see
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the IM dashboard appearing as shown below.

In the top row, you see a few icons. For now, we will discuss only the first icon
which represents Test Statistic Calculator. Using this calculator, you will enter the details of
interim look data analysis results into the IM dashboard.

Suppose we have the following data used by the Data Monitoring Committee during the first 5
looks of interim monitoring.

Date Total Deaths δ̂ SE(δ̂) Z-Statistic
Aug 96 125 -0.283 0.179 -1.581
Mar 97 299 -0.195 0.116 -1.681
Aug 97 423 -0.248 0.097 -2.557
Mar 98 545 -0.259 0.086 -3.012
Aug 98 670 -0.290 0.077 -3.766

The first look was taken at 125 events and the analysis of the data showed the value of δ=
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-0.283 and SE(δ)=0.179. First, click the blank row in the IM Dashboard and then click the
icon. Now you can enter the first analysis results into the TS calculator and click

Recalc. The Test Statistic value will be computed and the TS calculator will appear as shown
below.

Now click on the button ’OK’ to get the first look details into IM Dashboard. The following
message will appear that some required computations are being carried out.

After the computations are over, the output for the first look will appear in the IM Dashboard
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as shown below.

For the first look at total number of events, 125, the Information Fraction works out to be
0.101. The efficacy boundaries for this information fraction are newly computed. The Repeated
95% Confidence Interval limits and Repeated p-value are computed and displayed. You may
also see that the charts at the bottom of the IM Dashboard have been updated with relevant
details appearing on the side.

In a similar way, enter the interim analysis results for the next 3 looks in the IM Dashboard.
Now the IM Dashboard will look like this:

Now again click on the fifth row in IM Dashboard, enter the fifth look results into the Test
Statistic Calculator and click OK. This time, the boundary is crossed. A message window
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appears as shown below.

Click Stop and you will see the details of all the looks in the IM Dashboard as shown below.

The final Adjusted Inference output also appears as displayed below.

One important point to note here is that this study got over almost about 2 years ahead of
planned schedule, because of the very favorable interim analysis results.

This completes the Interim Monitoring exercise in this trial.

10.3 User Defined R Function
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East allows you to customize simulations by inserting user-defined R functions for one or more
of the following tasks: generate response, compute test statistic, randomize subjects, generate
arrival times, and generate dropout information. The R functionality for arrivals and dropouts
will be available only if you have entered such information at the design stage. Although the R
functions are also available for all normal and binomial endpoints, we will illustrate this
functionality for a time-to-event endpoint. Specifically, we will use an R function to generate
Weibull survival responses.

Start East afresh. On the Design tab, click Survival: Two Samples and then Logrank Test
Given Accrual Duration and Study Duration.

Choose the design parameters as shown below. In particular, select a one sided test with
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type-1 error of α = 0.025.

Click Compute and save this design (Des1) to the Library. Right-click Des1 in the Library and
click Simulate. In the Simulation Control Info tab, check the box for Suppress All

Intermediate Input. Type 10000 for Number of Simulations and select Clock for
Random Number Seed.

In the top right-hand corner for the input window, click Include Options, and then click User
Defined R Function.
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Go to the User Defined R Function tab. For now, leave the box Initialize R simulation
(optional) unchecked. This optional task can be used to load required libraries, set seeds for
simulations, and initialize global variables.

Select the row for Generate Response, click Browse..., and navigate to the folder containing
your R file. Select the file and click Open. The path should now be displayed under File Name.

Click View to open a notepad application to view your R file. In this example, we are
generating survival responses for both control and treatment arms from a Weibull with shape
parameter = 2 (i.e. exponential), with the same hazard rate in both arms. This sample file is
available in the folder named R Samples under installation directory of East 6.

Copy the function name (in this case GenWeibull) and paste it into the cell for Function Name.
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Save and close the R file, and click Simulate.

Return to the tab for User Defined R Function, select the Generate Response row, and click
View. In the R function, change the shape parameter = 1, to generate responses from a
Weibull distribution with increasing hazards. Save and close the R file, and click Simulate. You
may have to save this file on some other location.

Select both simulations (Sim1 and Sim2) from the Output Preview, and on the toolbar, click
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to display in the Output Summary.

Notice that the type-1 error appears to be controlled in both cases. When we simulated from
the exponential (Sim2), the average study duration (30.7 months) was close to what was
calculated at Des1 for the expected study duration under the null. However, when we
simulated from the Weibull with decreasing hazards (Sim1), the average study duration
increased to 34.6 months.

The ability to use custom R functions for many simulation tasks allows considerable flexibility
in performing sensitivity analyses and assessment of key operating characteristics.
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11 Superiority Trials with Variable
Follow-Up

This chapter will illustrate through a worked example how to design, monitor and simulate a
two-sample superiority trial with a time-to-event trial endpoint. Each subject who has not
dropped out or experienced the event is followed until the trial ends. This implies that a subject
who is enrolled earlier could potentially be followed for a longer time than a subject who is
enrolled later on in the trial. In East we refer to such designs as variable follow-up designs.

11.1 The RALES Clinical Trial: Initial Design

The RALES trial (Pitt et al., 1999) was a double blind study of aldosterone-receptor blocker
spironolactone at a daily dose of 25 mg in combination with standard doses of an ACE
inhibitor (treatment arm) versus standard therapy of an ACE inhibitor (control arm) in patients
who had severe heart failure as a result of systolic left ventricular dysfunction. The primary
endpoint was death from any cause. Six equally-spaced looks at the data using the
Lan-DeMets-O’Brien-Fleming spending function were planned. The trial was designed to
detect a hazard ratio of 0.83 with 90% power at a two-sided 0.05 level of significance. The
hazard rate of the control arm was estimated to be 0.38/year. The trial was expected to enroll
960 patients/year.

We begin by using East to design RALES under these basic assumptions. Open East, click
Design tab and then Two Samples button in Survival group. You will see the following
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screen.

Note that there are two choices available in the above list; Logrank Test Given Accrual
Duration and Accrual Rates and Logrank Test Given Accrual Duration and Study
Duration. The option Logrank Test Given Accrual Duration and Study Duration is
explained later in Chapter 13. Now click Logrank Test Given Accrual Duration and Accrual
Rates and you will get the following input dialog box.

In the above dialog box, enter 6 for Number of Looks and keep the default choices of Design
Type: Superiority, Test Type: 2­Sided, Type I Error (α): 0.05, Power : 0.9, and the
Allocation Ratio: 1.
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Further, keep the default choices of # of Hazard Pieces as 1 and the Input Method: as
Hazard Rates. Click the check box against Hazard Ratio and enter the Hazard Ratio as
0.83. Enter Hazard Rate (Control) as 0.38. You will see the Hazard Rate (Treatment:Alt)
computed as 0.3154. Also, keep the Variance of Log Hazard Ratio to be used as under
Null. Now the Design Parameters tab of the input dialog will appear as shown below.

Now click on the tab Boundary Info. You will see the following input dialog box.

Keep all the default specifications for the boundaries to be used in the design. You can look at
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the Error Spending Chart by clicking on the icon
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If you click on the boundary chart icon , you will see the boundary chart as displayed below.

Now click Accrual/Dropout Info tab. Keep the default choice Until End of Study for the
input Subjects are followed:. Keep the # of Accrual Periods as 1 and enter 960/year as the
accrual rate. For this example, assume no dropouts. The dialog box will look as shown below.

Under Accrual tab and in column titled Comtd. (commited) , you see two radio buttons
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Durations and Subjects with the latter selected by default. The selected item will appear as
the x-axis item in the Study Duration vs. Accrual chart, which you can get by clicking on the
icon displayed on the side. Against Durations and Subjects you see two rows of three cells
each. The first and third cells will show the min and max values for the row item and the
middle cell, mid value between min and max values.

From the results displayed, you see that any sample size in the range 1243 to 3111 will suffice
to attain the desired 90% power and selects 2177, the mid-point of the allowable range, as the
default sample size. Depending on the needs of the study, you may wish to use a different
sample size within the allowable range. The choice of sample size generally depends on how
long you wish the study to last. The larger you make the patient accrual the shorter will be the
total study duration, consisting of accrual time plus follow up time. To understand the essence

of this trade-off, bring up the Study Duration vs. Accrual chart by clicking on the icon
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.

Based on this chart, a sample size of 1660 subjects is selected. Enter 1660 for Committed
Accrual (subjects). Click on Compute and see the results in the new plan created under
Output Preview. This sample size ensures that the maximum study duration will be slightly
more than 4.9 years. Additionally, under the alternative hypothesis, the expected study
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duration will be only about 3.3 years.
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11.2 Incorporating Drop-Outs

The investigators expect 5% of the patients in both the groups to drop out each year. To
incorporate this drop-out rate into the design, in the Piecewise Constant Dropout

Rates tab, select 1 for the number of pieces and change the Input Method from Hazard

Rates to Dropout Rates. Then enter 5% dropouts at 1 year for both the groups.

We could have entered a hazard rate γ for dropping out instead. By solving
1− exp(−γ) = 0.05 we find γ = − ln(0.95) = 0.051. This calculation is handled by East

To make Plan1 and Plan2 comparable change the sample size of Plan2 to 1660 by typing this
value into the Committed Accrual (Subjects) cell. Click on Compute and see the
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results in the new plan created under Output Preview.

A comparison of the first and second plans reveals that, because of the drop-outs, the
maximum study duration will be prolonged from 4.9 years under Plan1 to 5.9 years under
Plan2. The expected study duration will likewise be prolonged from 3.3 years to 3.7 years
under the alternative hypothesis, and from 4.5 years to 5.3 years under the null hypothesis.

11.3 Incorporating Non-Constant Accrual Rates
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In many clinical trials, the enrollment rate is low in the beginning and reaches its maximum
expected level a few months later when all the sites enrolling patients have been recruited.
Suppose that patients are expected to enroll at an average rate of 400/year for the first six
months and at an average rate of 960/year thereafter. Now in Accrual Info tab, specify
that there are two accrual periods and enter the accrual rate for each period in the dialog box
as shown below.

Once again change the sample size to 1660 to make Plan3 comparable to the other two plans.
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Click on Compute to complete the design.

Notice that the enrollment period has increased from 1.7 years to 2 years. Likewise, the
maximum study duration and the expected study durations under H0 and H1 have also
increased relative to Plans 1 and 2. Now the maximum study duration is 6.15 years.

11.4 Incorporating Piecewise Constant Hazards

Prior studies had suggested that the survival curves might not follow an exponential
distribution. Suppose it is believed that the hazard rate for failure on the control arm
decreases after the first 12 months from 0.38 to 0.35. We will assume that the hazard ratio is
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still 0.83. We can enter the appropriate piecewise hazard rates into East as follows.

Change the sample size to 1660 for comparability with the previous plans. Click on Compute
and see the results of the plan in the Output Preview.

We observe that the impact of changing from a constant hazard rate to a piecewise constant
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hazard rate is substantial. The maximum study duration has increased from 6.15 years for
Plan3 to 6.56 years for Plan4.

11.5 Simulating a Trial with Proportional Hazards
11.5.1 Simulation Worksheet 11.5.2 Simulating Under H1 11.5.3 Simulating...

It would be useful to verify the operating characteristics of the various plans created in the
previous section by simulation. The new survival simulation capabilities in East permit this. Let
us use these capabilities to simulate Plan4. Save this design in the workbook. Right-click on
this design node and select the menu item Simulate. You’ll see the following Survival
Simulation worksheet.

11.5.1 Components of the Simulation Worksheet

This simulation worksheet consists four tabs - Simulation Parameters, Response
Generation Info, Accrual/Dropout Info, and Simulation Control Info. The Simulation
Parameters tab displays all the parameters of the simulation. If desired, you may modify one
or more of these parameter values before carrying out simulation. The second tab Response
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Generation Info will appear as shown below.

In this tab, you may modify values of response parameters before carrying out simulation. The
third tab Accrual/Dropout Info will display information relating to accrual and dropouts.

As in the case of other tabs, you may modify one or more values appearing in this tab before
simulation is carried out.

In the Simulation Control Info, you may specify the simulation parameters like number
of simulations required and the desired simulation seed etc.
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Also optionally, you may bring out one more tab Randomization Info by clicking on
Include Options. In the Randomization Info, you may alter the allocation ratio of the
design before carrying out simulation.

Keeping all the default parameter values same as in the different tabs, click Simulate. You
can see the progress of the simulation process summarized as shown in the following screen
shot.

At the end of simulation, the simulation results appear in a row in the Output Preview as
shown below.

The output summary can be seen by clicking on the icon after selecting the simulation
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row in the Output Preview.

Now save the simulation results to the workbook by selecting the simulation results row and
then clicking on . On this newly added workbook node for simulation, right-click and
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select Details. You will see the complete details simulation appearing on the output pane.

11.5.2 Simulating Under H1

We illustrate by running 1000 simulations for the current design with a fixed number of events
at each look. Select a look time definition based on the number of events and click on the
Simulate button. You will see a new row added in the Output Preview. Select this row and
save it to Library node. If you double-click this node, you will see the following detailed
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output. (The actual values may differ, depending on the starting seed used).

Let us examine these 1000 simulations more closely.

The column labeled Events in the first table, displays the number of events after which each
interim look was taken. The column labeled Avg. Look Time in the second table, displays
the average calendar times at which each interim look was taken. Thus, the first interim look
(taken after observing 207 events) occurred after an average elapse of about 1.5 years; the
second interim look (taken after observing 414 events) occurred after an average elapse of
about 2.1 years; etc. The remaining columns of the simulation output are self-explanatory. The
columns labeled Early Stopping For show that 911 of the 1000 simulations crossed the

11.5 Simulating a Trial with Prop.Hazards – 11.5.2 Simulating Under H1 245



<<< Contents * Index >>>

Chapter 11: Superiority Trials with Variable Follow-Up

lower stopping boundary, thus confirming (up to Monte Carlo accuracy) that this design has
90% power. The detailed output tables also show how the events, drop-outs, accruals, and
average follow-up times were observed at each interim analysis.

11.5.3 Simulating Under H0

To simulate under the null hypothesis we must go to the Response Generation Info tab.
In this pane change the hazard rate for the treatment arm to 0.38 for the first piece and to 0.35
for the second piece of the hazard function.

This change implies that we will be simulating under the null hypothesis. Click on the
Simulate button. A new row in Output Preview will be added now. Select this row and add
to the library node. By double-clicking on this node, you will see the detailed simulation
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output as shown below.The results are displayed below.

Out of 1000 simulated trials only 23 crossed the upper stopping boundary and 28 crossed the
lower stopping boundary thus confirming (up to Monte Carlo accuracy) that the type-1 error is
preserved for this design.

11.6 Simulating a Trial with Non-Proportional Hazards
11.6.1 Single-Look Design 11.6.2 Single-Look Design 11.6.3 Group Seq. Design

A new agent is to be tested against placebo in a large cardiovascular study with the endpoint
being time to stroke, MI or death. The control arm has a 12-month event-free rate of 97%. We
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wish to design the study to detect a hazard ratio of 0.75 with 90% power, using a two-sided
test conducted at the 0.05 level. An important design consideration is that treatment
differences are expected to emerge only after one year of therapy. Subjects will enroll at the
rate of 1000/month and be followed to the end of the study. The dropout rate is expected to
be 10% per year for both treatment arms. Finally, the study should be designed for maximum
study duration of 50 months.

The usual design options in East are not directly applicable to this trial because they require the
hazard ratio to be constant under the alternative hypothesis. Here, however, we are required
to power the trial to detect a hazard ratio of 0.75 that only emerges after patients have been
on the study for 12 months. The simulation capabilities of East can help us with the design.

11.6.1 Single-Look Design with Proportional Hazards

We begin by creating a single-look design powered to detect hazard ratio of 0.75, ignoring the
fact that the two survival curves separate out only after 12 months. Open a new survival design
worksheet by clicking on Design–>Time to Event–>Logrank Test Given Accrual Duration
and Accrual Rates. In the resulting Design Parameters tab, enter the parameters values
as shown below.

Click on the tab Accrual/Dropout Info and enter the values as shown below, excluding
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the Accrual tab.

East informs you in the Accrual tab, that any sample size in the range 2524 to 22260 will suffice
to attain the desired 90% power. However, the study will end sooner if we enroll more
patients. Recall that we wish the trial to last no more than 50 months, inclusive of accrual and
follow-up. The Accrual­Duration chart can provide guidance on sample size selection.
This chart reveals that if 6400 subjects are enrolled, the expected maximum duration of a trial
is close to 50 months.

Now change the Comtd. number of subjects to 6400 and click on Compute to complete the
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design. A new row is added for this design in the Output Preview. Select this row and add it to
a library node under a workbook. Now you double-click on this node, you will see the detailed
output as shown below.

We can verify the operating characteristics of Plan1 by simulation. With the cursor on Plan1
node, Click on Simulation icon from the library menu bar. You’ll be taken to the survival
simulation worksheet. In the Simulation Control Info tab, specify the number of
simulations to be 1000. Now click on Simulate button. This will generate 1000 simulations
from the survival curves specified in the design. Each simulation will consist of survival data on
6400 subjects entering the trial uniformly at the rate of 1000/month. Events (failures) will be
tracked and the simulated trial will be terminated when the total number of events equals 508.
Subjects surviving past this termination time point will have their survival times censored. The
resulting survival data will be summarized in terms of the logrank test statistic. Each simulation
records two important quantities:

the calendar time at which the last of the specified 508 events arrived;
whether or not the logrank test statistic rejected the null hypothesis.

We would expect that, on average, the 508 events will occur in about 48.7 months and about
90% of the simulations will reject the null hypothesis. The simulation summary is shown in the
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following screen shot.

Indeed we observe that the average study duration for this set of 1000 simulations was 48.8
months, and that 891 of the 1000 simulated trials crossed the critical value and rejected H0

and hence the power attained is 0.891. This serves as an independent verification of the
operating characteristics of Plan1, up to Monte Carlo accuracy.

11.6.2 Single-Look Design with Non-Proportional Hazards

Were it not for the fact that the hazard ratio of 0.75 only emerges after 12 months of therapy,
Plan1 would meet the goals of this study. However, the impact of the late separation of the
survival curves must be taken into consideration. This is accomplished, once again, by
simulation. Click the Edit Simulation icon while the cursor is on the last simulation node. In the
resulting simulation sheet click on Response Generation Info tab. In this tab, specify that the
hazard rates for the control and treatment arms are identical and equal to 0.0025 for the first
12 months and the hazard ratio is 0.75 thereafter. This is done by making appropriate entries
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in this tab as shown below.

Click on the Simulate button. This will generate 1000 simulations from survival curves
specified in the Survival Parameters Pane. As before, each simulation will consist of
survival data on 6400 subjects entering the trial uniformly at the rate of 1000/month. Events
(failures) will be tracked and the simulated trial will be terminated when the total number of
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events equals 508. The summary output of this simulation run as shown below.

This time only 565 of the 1000 trials were able to reject H0.The drop in power is of course due
to the fact that the two survival curves do not separate out until 12 months have elapsed. Thus
events that arise within the first 12 months arrive at the same rate for both arms and are not
very informative about treatment differences.

We need to increase the power of the study to 90%. This can be accomplished in one of two
ways:
1. Prolonging the study duration until a sufficient number of events are obtained to achieve
90% power.

2. Increasing the sample size.
The first approach cannot be used because the study duration is not permitted to exceed 50
months. The simulations have shown that the study duration is already almost 50 months, and
it has only achieved 56.5% power. Thus we must resort to increasing the sample size.
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Now if we increase the sample size while keeping the total number of events fixed at 508, the
average study duration will drop. The power, however, may not increase. In fact it might even
decrease since a larger fraction of the 508 events will arise in the first 12 months, before the
two survival curves have separated. To see this, increase the sample size from 6400 to 10000 in
the Accrual/Dropout Info tab. Then click on Simulate button. From this simulation run,
you will get the output summary as shown below.

Notice that the average study duration has dropped to 29.7 months. But the power has
dropped also. This time only 297 of the 1000 simulations could reject the null hypothesis.

To increase power we must increase sample size while keeping the study duration fixed at
about 50 months. This is accomplished by selecting the Look Time option from the
drop-down box in the Fix at Each Look section of the Survival Parameters Pane

and choosing a 50 month Total Study Durn., while keeping the sample size increase from 6400
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to 10000.

We will now run 1000 simulations in each of which 10000 subjects are enrolled at the rate of
1000/year. Each simulated trial will be terminated at the end of 50 months of calendar time
and a logrank test statistic will be derived from the data.Click on the Simulate button. Add
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the simulation run output to library node and see the following output summary.
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For more details, you can click icon after selecting the saved simulation node.

Now you can see, the power of the study has increased to 75.2%. On average 808 events
occurred during the 50 months that the study remained open. Since we require 90% power,
the sample size must be increased even further. This can be done by trial and error over
several simulation experiments. Eventually we discover that a sample size of 17200 patients
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will provide about 90% power with an average of 1304 events.

It is evident from these simulations that the proportional hazards assumption is simply not
appropriate if the survival curves separate out late. In the present example the proportional
hazards assumption would have led to a sample size of 6400 whereas the sample size actually
needed was 17200.

11.6.3 Group Sequential Design with Non-Proportional Hazards

The single-look design discussed in the previous section required a sample size of 17200
subjects. A group sequential design, monitored by an independent data monitoring
committee, is usually more efficient for large studies of this type. Such a trial can be designed
with efficacy stopping boundaries or with efficacy and futility stopping boundaries. Consider
first a design with five equally spaced efficacy boundaries. Go back to the library, click on Des1

258 11.6 Simulating a Trial with Non-Prop.Hazards – 11.6.3 Group Seq. Design



<<< Contents * Index >>>

East
R⃝
6.4

c⃝ Cytel Inc. Copyright 2017

node, and then click on . In the resulting design input dialog window, change the entry
in the Number of Looks cell from 1 to 5. Click on Compute button and save the plan as

Des2 in the library. Select Des1 and Des2 nodes and then click on to see the following
details for both the plans.

Des2 reveals that a group sequential design, with five equally spaced looks, taken after
observing 104, 208, 312, 416 and 520 events, respectively, utilizing the default
Lan-DeMets-O’Brien-Fleming (LD(OF)) spending function, achieves 90% power with a
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maximum sample size of 12555 and a maximum study duration of 27.232 months. The
expected study duration under H1 is 21.451 months. However, these operating characteristics
are based on the assumption that the hazard ratio is constant and equals 0.75. Since in fact
the hazard ratio is 0.75 only after 12 months of treatment, the actual power of this design is
unlikely to be 90%. We can use simulation to determine the actual power. With the cursor in

any cell of Des2 node, select from the menu bar. You will be taken to the simulation
worksheet. In the Response Generation Info tab, make the changes in the hazard rates
as shown below.

After changing the number of simulations as 1000 in the Simulation Control Info, click on the
Simulate button to run 1000 simulations of Des2 with data being generated from the
survival distributions that were specified in the Response Generation Info tab. The

260 11.6 Simulating a Trial with Non-Prop.Hazards – 11.6.3 Group Seq. Design



<<< Contents * Index >>>

East
R⃝
6.4

c⃝ Cytel Inc. Copyright 2017

results of this simulation run are as shown below.

Only 187 of the 1000 simulated trials were able to reject the null hypothesis indicating that the
study is grossly underpowered. We can improve on this performance by extending the total
study duration so that additional events may be observed. To increase study duration, go to
the Simulation Parameters tab and select the Look Time option under Fix at Each

Look. We had specified at the outset that the total study duration should not exceed 50
months. Let us therefore fix the total study duration at 50 months and space each interim look

11.6 Simulating a Trial with Non-Prop.Hazards – 11.6.3 Group Seq. Design 261



<<< Contents * Index >>>

Chapter 11: Superiority Trials with Variable Follow-Up

10 months apart by editing the Study Duration.

We are now ready to simulate a 5-look group sequential trial in which the LD(OF) stopping
boundaries are applied and the looks are spaced 10 months apart. Each simulated trial will
enroll 12555 subjects at the rate of 1000/month. The simulation data will be generated from
survival distributions in which the hazard rates of both arms are 0.0025 for the first 12 months
and the hazard ratio is 0.75 thereafter. To generate 1000 simulations of this design click on the
Simulate button. These simulations do indeed show a substantial increase in power, from
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18.7% previously to 79.9% .

The design specifications stated, however, that the trial should have 90% power. In order to
achieve this amount of power we will have to increase the sample size. By trial and error, upon
increasing the sample size to 18200 on the Simulation Parameters tab we observe that
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the power has increased to 90 % (up to Monte Carlo accuracy).
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11.7 Simulating a Trial with Stratification variables

The data presented in Appendix I of Kalbfleisch and Prentice (1980) on lung cancer patients
were used as a basis for this example. We will design a trial to compare two treatments
(Standard and Test) in a target patient group where patients had some prior therapy. The
response variable is the survival time in days of lung cancer patients. First, we will create a
design for 3 looks, to compare the two treatment groups. Next, using this design, we will carry
out simulation with stratification variables. Three covariates in the data are used here as
stratum variables: a) type of cancer cell (small, adeno, large, squamous,), b) age in years (<=50,
>50), and c) performance status score (<=50, >50 and <=70, >70).

The input data for base design are as follows: Trial type:superiority; test type:2-sided; type I
error:0.05; power:0.90; allocation ratio:1; hazard rate (control):0.009211; hazard rate
(treatment):0.004114; number of looks:3; Boundary family:spending functions; spending
function:Lan-DeMets (OF); subjects are followed:until end of study; subjects accrual rate:12 per
day.

The input data for stratified simulation are as given below: The number of stratum variables=3
(cell type; age group; performance status score).

11.7.1 Creating the design

First we will create a design using the input data. Open East, click Design tab and then Time
to Event button in Survival group. Now click Logrank Test: Given Accrual Duration and
Accrual Rates. In the resulting screen, enter the input data in the dialog boxes under the
different tabs. Finally click on Compute button. Now the dialog boxes under the different tabs
will appear as shown below.

The Design Parameters tab is shown below, where you can see the computed value of No.of
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Table 11.4: Input data for stratified simulation

Cell type Proportion Hazard ratio
small 0.28 Baseline
adeno 0.13 2.127
large 0.25 0.528

squamous 0.34 0.413

Age group Proportion Hazard ratio
≤ 50 years 0.28 Baseline
> 50 years 0.72 0.438

Performance status score group Proportion Hazard ratio
≤ 50 0.43 Baseline

> 50 and ≤ 70 0.37 0.164
> 70 0.20 0.159

Events.
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The Boundary Info will appear as shown below, where all the input data are seen.

The Accrual/Dropout Info tab containing the input data will be as shown below.

After the design is completed and saved in a workbook, select the design node and click on
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the output summary icon to see the following output display.

11.7.2 Running Stratified Simulation
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After selecting the design node, click on Simulate icon. You will see simulation screen with the
dialog boxes under different tabs. Click on Include Options and select Stratification Info.

The dialog box under Simulation Parameters will be as shown below. Keep the default test
statistic LogRank and the default choice of Use Stratified Statistic.

After entering the stratification input information, the dialog box under Stratification Info will
appear as shown below.

After entering adding response related input information, the dialog box under Response
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Generation Info will display details as shown in the following screen shots.
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The Accrual/Dropout Info dialog box will appear as shown below.

In the Simulation Control Info tab, specify number of simulations as 1000 and select the
choices under output options to save simulation data. The dialog box will appear as shown
below.

After clicking on Simulate button, the results will appear in the Output Preview row. Click on it
and save it in the workbook. Select this simulation node and click on Output Summary icon
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to see the following stratification simulation output summary.

The stratified simulation results show that the attained power 0.856 is slightly less than the
design specified power of 0.90.
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12
Non-Inferiority Trials Given
Accrual Duration and Accrual
Rates

This chapter will illustrate through a worked example how to design, monitor and simulate a
two-sample non-inferiority trial with a time-to-event trial endpoint, when the accrual duration
and accrual rates are fixed.

12.1 Establishing the Non-Inferiority Margin

The first step in designing a non-inferiority trial is to establish a suitable non-inferiority margin.
This is typically done by performing a meta-analysis on past clinical trials of the active control
versus placebo. Regulatory agencies then require the sponsor of the clinical trial to
demonstrate that a fixed percentage of the active control effect (usually 50%) is retained by
the new treatment. A further complication arises because the active control effect can only be
estimated with error. We illustrate below with an example provided by reviewers at the FDA.

Rothman et al. (2003) have discussed a clinical trial to establish the non-inferiority of the test
drug Xeloda (treatment t) relative to the active control (treatment c) consisting of
5-fluorouracil with leucovarin (5FU+LV) for metastatic colorectal cancer. In order to establish a
suitable non-inferiority margin for this trial it is necessary to first establish the effect of 5FU+LV
relative to the reference therapy of 5FU alone (treatment p, here regarded as placebo). To
establish this effect the FDA conducted a ten-study random effects meta-analysis (FDA
Medical-Statistical review for Xeloda, NDA 20-896, April 2001) of randomized comparisons of
5-FU alone versus 5-FU+LV. Letting λt, λc and λp denote the constant hazard rates for the new
treatment, the active control and the placebo, respectively, the FDA meta-analysis established
that

ln ̂(λp/λc) = 0.234
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with standard error
se[ln ̂(λp/λc)] = 0.075 .

Thus with 100γ% confidence the active control effect lies inside the interval

[0.234− 0.075Φ−1(
1 + γ

2
), 0.234 + 0.075Φ−1(

1 + γ

2
)] (12.1)

The new study is required to demonstrate that some fraction (usually 50%) of the active
control effect is retained. Rothman et al. (2003) state that the claim of non-inferiority for the
new treatment relative to the active control can be demonstrated if the upper limit of a
two-sided 100(1− α)% confidence interval for ln(λt/λc) is less than a pre-specified fraction of
the lower limit of a two-sided 100γ% confidence interval for the active control effect
established by the meta-analysis. This is known as the “two confidence intervals procedure”.
Specifically in order to claim non-inferiority in the current trial it is necessary to show that

ln ̂(λt/λc) + Φ−1(1− α/2)se[ln ̂(λt/λc)] < (1− f0){ln ̂(λp/λc)− Φ−1(
1 + γ

2
)se[ln ̂(λp/λc)]} .

(12.2)
We may re-write the non-inferiority condition (12.2) in terms of a one-sided Wald test of the
form

ln ̂(λt/λc)− δ0

se[ln ̂(λt/λc)]
< Φ−1(1− α/2) , (12.3)

where
δ0 = (1− f0){ln ̂(λp/λc)− Φ−1(

1 + γ

2
)se[ln ̂(λp/λc)]} (12.4)

is the non-inferiority margin.

The choice f0 = 1 implies that the entire active control effect must be retained in the new trial
and amounts to running a superiority trial. At the other end of the spectrum, the choice f0 = 0

implies that none of the active control effect need be retained; i.e., the new treatment is only
required to demonstrate effectiveness relative to placebo. The usual choice is f0 = 0.5,
implying that the new treatment is required to retain at least 50% of the active control effect.
The usual choice for α is α = 0.05. A conservative choice for the coefficient γ is
γ = (1− α) = 0.95. Rothman et al. (2003) refer to this method of establishing the
non-inferiority margin as the “two 95 percent two-sided confidence interval procedure” or the
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“95-95 rule”. In general this approach leads to rather tight margins unless the active control
effect is substantial. Rothman et al. (2003) have also proposed more lenient margins that vary
with the amount of power desired. Fleming (2007), however, argues for the stricter 95-95 rule
on the grounds that it offers greater protection against an ineffective medical compound
being approved in the event that the results of the previous trials used to establish the active
control effect are of questionable relevance to the current setting. Accordingly we
evaluate (12.4) with γ = 0.95, f0 = 0.5, ln ̂(λp/λc) = 0.234 and se[ln ̂(λp/λc)] = 0.075 thereby
obtaining the non-inferiority margin to be δ0 = 0.044 for the log hazard ratio and
exp(0.044) = 1.045 for the hazard ratio.

12.2 Design of Metastatic Colorectal Cancer Trial
12.2.1 Single-Look Design 12.2.2 Early Stopping for Futility

In this section we will use East to design a single-look non-inferiority trial comparing the test
drug Xeloda (treament t) to the active control 5FU+LV (treatment c) for the treatment of
metastatic colorectal cancer. On the basis of a meta-analysis of ten previous studies of the
active control versus placebo (Rothman et al., 2003), a non-inferiority margin of 1.045 for λt/λc

has been established. Thus we are interested in testing the null hypothesis of inferiority
H0: λt/λc ≥ 1.045 versus the one-sided alternative hypothesis that λt/λc < 1.045. Subjects are
expected to enroll at the rate of 60/month and the median survival time for patients
randomized to the active control arm is expected to be 18 months.

12.2.1 Single-Look Design

We will use East to create an initial single-look design having 80% power to detect the
alternative hypothesis H1: λt/λc = 1 with a one sided level 0.025 non-inferiority test.

To begin click Survival: Two Samples on the Design tab and then click Parallel Design: Log
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Rank Test Given Accrual Duration and Accrual Rates.

A new screen will appear. Enter the appropriate design parameters into the dialog box as
shown below.

The box labeled Variance of Log Hazard Ratio specifies whether the calculation of the
required number of events is to be based on the variance estimate of the log hazard ratio
under the null hypothesis or the alternative hypothesis. The default choice in East is Null.
Most textbooks recommend this choice as well (see, for example Collett, 1994, equation (2.21)
specialized to no ties). It will usually not be necessary to change this default. For a technical
discussion of this issue refer to Appendix ??, Section ??.

Next click on the Accrual/Dropout Info tab. Here we will specify the accrual information and
dropout rates. Enter an accrual rate of 60. Suppose that there are 5% drop-outs per year in
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each arm. Enter these values as shown below.

On the bottom of this screen is where you can specify the accrual duration or number of
subjects. East automatically computes a range that is necessary to achieve the desired power
of the study and selects the midpoint of the range, as the committed accrual duration or
subjects. If your study has a restriction on accrual duration or subject accrual, you may enter
this value in the Comtd. column. In our example, East computes a minimum accrual duration

of 300.05 months and a suggested maximum of 323.4 months. Also, if you click the icon
a chart which shows the relationship between accrual duration (or subject accrual, depending
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on whether you choose to specify accrual duration or subject accrual) and study duration.

Looking at this chart, choosing an accrual duration longer that 315 months will not result in a
substantial decrease in study duration. Thus, we commit to an accrual duration of 315 months.
Close this chart, select the radio button next to Duration and enter 315 in the Comtd. column.

Click on Compute to complete the design. The design is shown as a row in the Output
Preview located in the lower pane of this window. You can select this design by clicking

anywhere along the row in the Output Preview. With Des1 selected, click the icon to
display the details of this design in the upper pane, which are shown below. You may also wish
to save this design. Select Des1 in the Output Preview window and click the to save
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this design to Workbook1 in the Library.

It is immediately evident that Des1 is untenable. It requires 16,205 events to be fully powered.
The problem lies with trying to power the trial to detect a hazard ratio of 1 under the
alternative hypothesis. Suppose instead that the investigators actually believe that the
treatment is slightly superior to the active control, but the difference is too small to be
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detected in a superiority trial. In that case a non-inferiority design powered at a hazard ratio
less than 1 (0.95, say) would be a better option because such a trial would require fewer events.

To see this create a new design by selecting Des1 in the Library, and clicking the icon
on the Library toolbar. Then edit this design by specifying a hazard ratio of 0.95 under the
alternative hypothesis as shown below.

Next, click on the Accrual/Dropout Info tab. Notice that the minimum and suggested

maximum accrual have changed to 64.167 and 87.45 months, respectively. Click the
icon to display the study duration versus accrual chart.
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Suppose that after examining this chart, you decide that an accrual duration longer than 77
months is not worth the small decrease in study duration one would gain from a longer
accrual duration. Close this chart. Select the radio button next to Duration and enter 77 in the
Comtd. column.

Click the Compute button to generate output for Des2. With Des2 selected in the Output
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Preview, click the icon to save Des2 to the Library. In the Library, select the rows for

Des1 and Des2, by holding the Ctrl key, and then click the icon. The upper pane will
display the details of the two designs side-by-side:

Des2 is clearly easier to implement than Des1. It requires only 3,457 events and 4620 subjects
to be fully powered. Also note the marked decrease in study duration under either the null or
alternative hypothesis. Nevertheless, Des2 is also unsatisfactory. The maximum study duration
for Des2 (accrual plus follow-up) is 90.9 months with 77 months of that amount of time being
utilized to enroll 4620 patients. It is necessary to shorten the maximum study duration further.
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One possible way to shorten the maximum study duration is to increase the rate of enrollment.
Suppose that additional sites can be enlisted to enroll patients after the study is activated so
that six months later the average rate of enrollment is increased to 110/month. To see the

impact of the increased rate of enrollment select Des2 in the Library, and click on the
icon on the Library toolbar.

Next, click on the Accrual/Dropout Info tab. Change the accrual rates as shown below.

Notice how East automatically updates the accrual duration and subject accrual. An accrual
duration in the range of 35 to 56.664 months is sufficient to achieve the desired power.
Suppose that after examining the study duration versus accrual chart, we decide on an accrual
duration of 49 months. Enter 49 in the Comtd. column.

Click the Compute button to generate output for Des3. With Des3 selected in the Output
Preview, click the icon to save Des3 to the Library. In the Library, select the rows for

Des1, Des2, and Des3 by holding the Ctrl key, and then click the icon. The upper pane
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will display the details of the three designs side-by-side:

Des3 also requires 3457 events. However, because of the faster rate of enrollment the time
that it takes to obtain these events is cut down to 58.5 months.

12.2.2 Early Stopping for Futility

Under the null hypothesis Des3, with 3457 events, has an expected study duration of 57.2
months. This is a very long time commitment for a trial that is unlikely to be successful.
Therefore it would be a good idea to introduce a futility boundary for possible early stopping.
Since we wish to be fairly aggressive about early stopping for futility we will generate the
futility boundary from the Gamma(−1) β-spending function. On the other hand, since there is
no interest in early stopping for efficacy, we will not use an efficacy boundary.
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Create a new design by selecting Des3 in the Library, and clicking the icon on the
Library toolbar. Change the number of looks from 1 to 3. Next, click on the Boundary Info
tab. Enter the parameters as shown below. Be sure to select the Non-Binding option. This
choice gives us the flexibility to continue the trial even if a futility boundary has been crossed.
Data monitoring committees usually want this flexibility; for example, to follow a secondary
endpoint.

Next click on the Accrual/Dropout Info tab. Once again, East automatically computes the
minimum and suggested maximum values for the accrual duration and subject accrual. Click

the icon to display the study duration versus accrual chart. Notice that another line is
added to the chart. Now, we can see the maximum study duration vs accrual under the null
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hypothesis.

Suppose that after examining this chart, you decide to set the accrual duration at 49 months.
Any increase in accrual duration past 49 months will not result in a substantial decrease in
study duration. Close this chart. Select the radio button for Duration and enter 49 in the
Comtd. column.

Click the Compute button to generate output for Des4. With Des4 selected in the Output
Preview, click the icon to save Des4 to the Library. In the Library, select the rows for

Des3 and Des4 by holding the Ctrl key, and then click the icon. The upper pane will

286 12.2 Trial Design – 12.2.2 Early Stopping for Futility



<<< Contents * Index >>>

East
R⃝
6.4

c⃝ Cytel Inc. Copyright 2017

display the details of the two designs side-by-side:

Observe that while the maximum study duration has been inflated by about 6 months
compared to Des3, the expected study duration under H0 has been cut down by almost 18
months.

It would be useful to simulate Des4 under a variety of scenarios for the hazard ratio. Select

Des4 in the Library and click the icon. You will be taken to the following simulation
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worksheet.

We wish to simulate this trial under the null hypothesis that the hazard ratio is
exp(0.044) = 1.045. To this end click on the Response Generation Info tab. In this tab change
the control and treatment hazard rates as shown below.

Next, click the Simulate button to simulate 10000 trials. A new row labeled Sim1 will appear in
the Output Preview window. Select Sim1 in the Output Preview and click the icon to
save it to the Library. In the Library, double-click Sim1. A portion of the output is displayed
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below. (The actual values may differ, depending on the starting seed used).

Note that 205 out of the 10000 simulations were unable to reject the alternative hypothesis,
thus confirming (up to Monte Carlo accuracy) that this design achieves a type-1 error of 2.5%.
Also, observe that 50.08% of these trials have crossed the futility boundary at the very first
interim look after only 29.205 months of study duration.

12.3 Interim Monitoring

Suppose we have adopted Des4. Let us monitor the trial with the help of the Interim
Monitoring Worksheet. Select Des4 in the Library, and click the icon from the Library
toolbar. Alternatively, right-click on Des4 and select IM Dashboard. The interim monitoring
dashboard contains various controls for monitoring the trial, and is divided into two sections.
The top section contains several columns for displaying output values based on the interim
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inputs. The bottom section contains four charts, each with a corresponding table to its right.
These charts provide graphical and numerical descriptions of the progress of the clinical trial
and are useful tools for decision making by a data monitoring committee.

Suppose that the first interim look is taken after observing 1300 events. The observed hazard
ratio is 1.15 and the standard error of the log hazard ratio is 0.06. Enter this information into
the interim monitoring worksheet using Test Statistic calculator. Click on and
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enter the data in the test statistic calculator as shown below.

Next, click OK. East will indicate that theH1 (futility) boundary has been crossed and hence, the
alternative hypothesis of non-inferiority is rejected in favor of the null hypothesis of inferiority.

Click the Stop button to terminate the trial. You will see the IM sheet output including Final
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Inference details as shown below.

Observe that the upper 97.5% confidence bound for δ, 0.257, is above the non-inferiority
margin of 0.044 (on the log hazard ratio scale).
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Duration and Study Duration

This chapter will illustrate through a worked example how to design and simulate a
two-sample superiority trial with a time-to-event trial endpoint, where the accrual duration
and study duration are constrained. Most trials in the pharmaceutical industry setting are
designed in this manner, time being a more rigid constraint than the accrual rate of patients.
The duration of a clinical trial impacts the duration of a drug development program, and thus
time to market and potential revenues. Therefore it is of interest to fix the study duration as
well as the accrual duration to finish the clinical trial according to schedule. The option to
design a trial in this way is available in East.

13.1 Calculating a Sample Size

For this design, East obtains the maximum number of events Dmax from the maximum
information Imax, as described in Appendix sections ?? and ??. To calculate the sample size,
we first equate the expected number of events d(Sa + Sf ) (as calculated in Appendix ?? which
depends on the accrual duration (Sa) and the duration of follow-up (Sf ) to the maximum
number of events Dmax.

d(Sa + Sf ) = Dmax (13.1)

In this type of design the accrual duration Sa and the study duration Sa + Sf are given as
input. East iterates between sample sizes, increasing onwards from a minimum value of Dmax,
enrolled over a duration of Sa until Dmax events are found to occur within a study duration of
Sa+Sf . The result is the unique sample size required to obtain the proper power for the study.
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13.2 The RALES Clinical Trial: Initial Design

The RALES trial (Pitt et. al., 1999) was a double blind study of aldosterone-receptor blocker
spironolactone at a daily dose of 25 mg in combination with standard doses of an ACE
inhibitor (treatment arm) versus standard therapy of an ACE inhibitor (control arm) in patients
who had severe heart failure as a result of systolic left ventricular dysfunction. The primary
endpoint was death from any cause. Six equally-spaced looks at the data using the
Lan-DeMets-O’Brien-Fleming spending function were planned. The trial was designed to
detect a hazard ratio of 0.83 with 90% power at a two-sided 0.05 level of significance. The
hazard rate of the control arm was estimated to be 0.38.

Randomization was scheduled to begin in March 1995 and complete in December 1996 for a
total of 1.8 years of enrollment. Follow-up was planned through December 1999, so that the
total study duration from first patient enrolled to last patient visit should be 4.8 years.

We begin by using East to design RALES under these basic assumptions. To begin click
Survival: Two Samples on the Design tab and then click Parallel Design: Logrank Test
Given Accrual Duration and Study Duration as shown below

A new screen will appear. Enter the appropriate design parameters into the dialog box as
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shown below.

The box labeled Variance of Log Hazard Ratio specifies whether the calculation of the
required number of events is to be based on the variance estimate of the log hazard ratio
under the null hypothesis or the alternative hypothesis. The default choice in East is Null.
Most textbooks recommend this choice as well (see, for example Collett, 1994, equation (2.21)
specialized to no ties). It will usually not be necessary to change this default. For a technical
discussion of this issue refer to Appendix ??, Section ??.

Next, click on the Boundary Info tab. We will take six equally spaced looks at the data using
the Lan-DeMets O’Brien-Fleming spending function. These are the default setting in East.
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Note that we do not select a futility boundary in this case. Next click on the Accrual/Dropout
Info tab. Here we will specify the accrual information and dropout rates. The software allows a
specification of piecewise constant hazards and variable accrual rates but we start by looking
at an example that does not require any of these options. In the drop-down menu next to
Subjects are followed: select Until End of Study. Set the Accrual Duration to 1.8 years
and the Study Duration to 4.8 years. Notice that East has changed the settings so that at 1.8
years the study should be 100% accrued. Keep the number of accrual periods equal to the
default of 1. To the right of the Accrual Info box is the Piecewise Constant Dropout Rates
box. This box is used to enter that rate at which we expect patients to drop out of the study.
For the present we will assume that there are no drop-outs.

Click on Compute to complete the design. The design is shown as a row in the Output
Preview located in the lower pane of this window. You can select this design by clicking

anywhere along the row in the Output Preview. With Des1 selected, click the icon to
display the details of this design in the upper pane, which are shown below. You may also wish
to save this design. Select Des1 in the Output Preview window and click the to save
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this design to Workbook1 in the Library.

East notifies you that 1243 events and a sample size of 1689 are required to attain the desired
90% power in the allotted time.

East provides charts to examine the trade-offs between power and accrual duration, study
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duration, sample size or number of events. Select Des1 in the Library click the icon and
select Power vs. Sample Size as shown below.

To the right of the graph, swith the X-Axis to Accrual Duration.

This graph shows for a fixed study duration of 4.8 years and a fixed sample size of 1689, the
trade-off between power and accrual duration. For 1 year accrual, we see that the power will
be 91.3%.

Now switch the X-Axis option from Accrual Duration to Sample Size. You will see the
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following chart.

You can see that for a fixed Accrual Duration of 1.8 years and a fixed Study Duration of 4.8
years, 1170 subjects would provide you with 76.9% power. Switch the X-Axis option again,
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this time to Study Duration. The following chart will appear.

Here we see that closing the trial early after 4 years, given an accrual of 1689 patients over 1.8
years, we only have 86% power to detect the alternative hypothesis of interest. Finally, switch
the X-Axis to No. of Events. The power of the study is really tied to the number of
events that are observed. This chart shows the direct relationship between power and number

300 13.2 The RALES Clinical Trial: Initial Design



<<< Contents * Index >>>

East
R⃝
6.4

c⃝ Cytel Inc. Copyright 2017

of events.

Note that 950 events give us about 81% power. You may wish to save some or all of these
charts to the Library by clicking on the Save in Workbook button.

13.3 Incorporating Drop-Outs

The investigators expect 5% of the patients in the spironolactone group and the control group
to drop out each year. Create a new design by selecting Des1 in the Library, and clicking the

icon on the Library toolbar. Next, click on the Accrual/Dropout Info tab. In the
Piecewise Constant Dropout Rates box, select 1 for the number of pieces and change the
Input Method from Hazard Rates to Dropout Rates. Then enter 5% dropouts at 1 year
for the treatment and control arm as shown below. Although East allows you to specify
different dropout (hazard) rates for the two groups, it is recommended that you select equal
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dropout (hazard) rates.

Click the Compute button to generate output for Des2. With Des2 selected in the Output
Preview, click the icon to save Des2 to the Library. In the Library, select the rows for

Des1 and Des2, by holding the Ctrl key, and then click the icon. The upper pane will
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display the details of the two designs side-by-side:

A comparison of the two plans reveals that, because of the drop-outs, we require 1,824
subjects to be enrolled under Des2 rather than 1689 under Des1. Also, the expected study
duration will not change much under the alternative and null hypotheses between Des1 and
Des2.

13.4 Incorporating Non-Constant Accrual Rates
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In many clinical trials the enrollment rate is low in the beginning and reaches its maximum
expected level a few months later when all the sites enrolling patients are onboard. Suppose
that 20% of the total accrual is expected to occur during the first six months with the rest
happening during the remaining 1.3 years. Create a new design by selecting Des2 in the

Library, and clicking the icon on the Library toolbar. Next, click on the
Accrual/Dropout Info tab. Specify that there are two accrual periods and enter the
cumulative accrual for each period in the dialog box as shown below.

Click the Compute button to generate output for Des3. With Des3 selected in the Output
Preview, click the icon to save Des3 to the Library. In the Library, select the rows for

Des1, Des2, and Des3 by holding the Ctrl key, and then click the icon. The upper pane
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will display the details of the three designs side-by-side:

Notice that we now need 1837 subjects to be enrolled to compensate for the overall later
enrollment of subjects.

13.5 Simulation
13.5.1 Simulating Under H1 13.5.2 Simulating Under H0

It would be useful to verify the operating characteristics of the various plans created in the

previous section by simulation. Select Des3 in the Library and click the icon. You will be
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taken to the following simulation worksheet.

13.5.1 Simulating Under H1

We will first simulate the trial under the alternative hypothesis H1. In the Simulation
Parameters tab select Total No. of Events to fix at each look - the default option.
Select LogRank from the drop-down menu next to Test Statistic. Other options for a test
statistic include the Wilcoxon-Gehan and Harrington-Flemming. Next, click the Simulate
button to simulate 10000 trials. A new row labeled Sim1 will appear in the Output Preview
window. Select Sim1 in the Output Preview and click the icon to save it to the Library.
In the Library, double-click Sim1. A portion of the output is displayed below. (The actual
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values may differ, depending on the starting seed used).

The column labeled Average Look Time displays the average calendar times at which each
interim look was taken. Thus, the first interim look (taken after observing 207 events) occurred
after an average elapse of 1.254 years; the second interim look (taken after observing 414
events) occurred after an average elapse of 1.768 years; etc. We see that 8999 of the 10000
simulations crossed the lower stopping boundary, thus confirming (up to Monte Carlo
accuracy) that this design has 90% power.

We will now run another 10000 simulations, this time fixing the calendar time of each look

instead of fixing the number of events. Select Des3 in the Library and click the icon. In
the Simulation Parameters tab select Look Time from the drop-down menu next to Fix at
Each Look:.

When the Look Time option is selected the locations of the interim looks at which stopping
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boundaries are computed are expressed in terms of the calendar time of each interim look
instead of the number of events at each interim look.

Next, click the Simulate button to simulate 10000 trials. A new row labeled Sim2 will appear in
the Output Preview window. Select Sim2 in the Output Preview and click the icon to
save it to the Library. In the Library, double-click Sim2. A portion of the output is displayed
below. (The actual values may differ, depending on the starting seed used).

We see that the first interim look is taken, on average, after 1.256 years during which time an
average of 206.99 events are observed. In our simulations we have achieved 90.5% power,
thus confirming (up to Monte Carlo accuracy) that the study has 90% power.

13.5.2 Simulating Under H0

To simulate under the null hypothesis we must go to the Response Generation Info tab in
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the simulation worksheet. In this tab change the hazard rate for the treatment arm to 0.38.

This change implies that we will be simulating under the null hypothesis. Next, click on the
Simulation Parameters tab and make sure that the Total No. of Events is fixed at
each look. Next, click the Simulate button to simulate 10000 trials. A portion of the results are
displayed below.

Out of 10000 simulated trials 244 crossed the lower stopping boundary and 256 crossed the
upper stopping boundary thus confirming (up to Monte Carlo accuracy) that the type-1 error
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is preserved for this design.

13.6 User Defined R Function

East allows you to customize simulations by inserting user-defined R functions for one or more
of the following tasks: generate response, compute test statistic, randomize subjects, generate
arrival times, and generate dropout information. The R functionality for arrivals and dropouts
will be available only if you have entered such information at the design stage. Although the R
functions are also available for all normal and binomial endpoints, we will illustrate this
functionality for a time-to-event endpoint. Specifically, we will use an R function to generate
Weibull survival responses.

Start East afresh. On the Design tab, click Survival: Two Samples and then Logrank Test
Given Accrual Duration and Study Duration.

Choose the design parameters as shown below. In particular, select a one sided test with
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type-1 error of α = 0.025.

Click Compute and save this design (Des1) to the Library. Right-click Des1 in the Library and
click Simulate. In the Simulation Control Info tab, check the box for Suppress All

Intermediate Input. Type 10000 for Number of Simulations and select Clock for
Random Number Seed.

In the top right-hand corner for the input window, click Include Options, and then click User
Defined R Function.
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For now, leave the box Initialize R simulation (optional) unchecked. This optional task can
be useful for loading required libraries, setting seeds for simulations, and initializing global
variables.

Select the row for Generate Response, click Browse..., and navigate to the folder containing
your R file. Select the file and click Open. The path should now be displayed under File Name.

Click View to open a notepad application to view your R file. In this example, I am generating
survival responses for both control and treatment arms from a Weibull with shape parameter
= 1 (i.e. exponential), with the same hazard rate in both arms.

Copy the function name (in this case GenWeibull) and paste it into the cell for Function Name.

312 13.6 User Defined R Function



<<< Contents * Index >>>

East
R⃝
6.4

c⃝ Cytel Inc. Copyright 2017

Save and close the R file, and click Simulate.

Return to the tab for User Defined R Function, select the Generate Response row, and click
View. In the R function, change the shape parameter = 2, to generate responses from a
Weibull distribution with increasing hazards. Save and close the R file, and click Simulate.

Select both simulations (Sim1 and Sim2) from the Output Preview, and on the toolbar, click
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to display in the Output Summary.

Notice that the type-1 error appears to be controlled in both cases. When we simulated from
the exponential (Sim1), the average study duration (30.7 months) was close to what was
calculated at Des1 for the expected study duration under the null. However, when we
simulated from the Weibull with decreasing hazards (Sim2), the average study duration
increased to 34.6 months.

Appendix ?? contains detailed specifications for the required inputs and outputs of R
functions for each task and endpoint. The ability to use custom R functions for many
simulation tasks allows considerable flexibility in performing sensitivity analyses and
assessment of key operating characteristics.

314 13.6 User Defined R Function



<<< Contents * Index >>>

14
Non Inferiority Trials Given
Accrual Duration and Study
Duration

This chapter will illustrate through a worked example how to design and simulate a
two-sample non inferiority trial with a time to event trial endpoint, when the accrual duration
and study duration are fixed.

14.1 Calculating a Sample Size

For this design, East obtains the maximum number of events Dmax from the maximum
information Imax, as described in Appendix sections ?? and ??. To calculate the sample size,
we first equate the expected number of events d(Sa + Sf ) (as calculated in Appendix ?? which
depends on the accrual duration (Sa) and the duration of follow-up (Sf ) to the maximum
number of events Dmax.

d(Sa + Sf ) = Dmax (14.1)

In this type of design the accrual duration Sa and the study duration Sa + Sf are given as
input. East iterates between sample sizes, increasing onwards from a minimum value of Dmax,
enrolled over a duration of Sa until Dmax events are found to occur within a study duration of
Sa+Sf . The result is the unique sample size required to obtain the proper power for the study.

14.2 The Non Inferiority Margin

The first step in designing a non-inferiority trial is to establish a suitable non inferiority margin.
This is typically done by performing a meta-analysis on past clinical trials of the active control
versus placebo. Regulatory agencies then require the sponsor of the clinical trial to
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demonstrate that a fixed percentage of the active control effect (usually 50%) is retained by
the new treatment. A further complication arises because the active control effect can only be
estimated with error. We illustrate below with an example provided by reviewers at the FDA.

Rothman et al. (2003) have discussed a clinical trial to establish the non inferiority of the test
drug Xeloda (treatment t) relative to the active control (treatment c) consisting of 5 fluorouracil
with leucovarin (5FU+LV) for metastatic colorectal cancer. In order to establish a suitable non
inferiority margin for this trial it is necessary to first establish the effect of 5FU+LV relative to
the reference therapy of 5FU alone (treatment p, here regarded as placebo). To establish this
effect the FDA conducted a ten study random effects meta analysis (FDA Medical Statistical
review for Xeloda, NDA 20 896, April 2001) of randomized comparisons of 5-FU alone versus
5-FU+LV. Letting λt, λc and λp denote the constant hazard rates for the new treatment, the
active control and the placebo, respectively, the FDA meta analysis established that

ln ̂(λp/λc) = 0.234

with standard error
se[ln ̂(λp/λc)] = 0.075 .

Thus with 100γ% confidence the active control effect lies inside the interval

[0.234− 0.075Φ−1(
1 + γ

2
), 0.234 + 0.075Φ1(

1 + γ

2
)] (14.2)

The new study is required to demonstrate that some fraction (usually 50%) of the active
control effect is retained. Rothman et al. (2003) state that the claim of non inferiority for the
new treatment relative to the active control can be demonstrated if the upper limit of a two
sided 100(1− α)% confidence interval for ln(λt/λc) is less than a pre specified fraction of the
lower limit of a two sided 100γ% confidence interval for the active control effect established by
the meta-analysis. This is known as the “two confidence intervals procedure”. Specifically in
order to claim non inferiority in the current trial it is necessary to show that

ln ̂(λt/λc) + Φ−1(1− α/2)se[ln ̂(λt/λc)] < (1− f0){ln ̂(λp/λc)− Φ−1(
1 + γ

2
)se[ln ̂(λp/λc)]} .

(14.3)
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We may re-write the non inferiority condition (14.3) in terms of a one-sided Wald test of the
form

ln ̂(λt/λc)− δ0

se[ln ̂(λt/λc)]
< Φ−1(1− α/2) , (14.4)

where
δ0 = (1− f0){ln ̂(λp/λc)− Φ−1(

1 + γ

2
)se[ln ̂(λp/λc)]} (14.5)

is the non inferiority margin.

The choice f0 = 1 implies that the entire active control effect must be retained in the new trial
and amounts to running a superiority trial. At the other end of the spectrum, the choice f0 = 0

implies that none of the active control effect need be retained; i.e., the new treatment is only
required to demonstrate effectiveness relative to placebo. The usual choice is f0 = 0.5,
implying that the new treatment is required to retain at least 50% of the active control effect.
The usual choice for α is α = 0.05. A conservative choice for the coefficient γ is
γ = (1− α) = 0.95. Rothman et al. (2003) refer to this method of establishing the non
inferiority margin as the “two 95 percent two sided confidence interval procedure” or the
“95-95 rule”. In general this approach leads to rather tight margins unless the active control
effect is substantial. Rothman et al. (2003) have also proposed more lenient margins that vary
with the amount of power desired. Fleming (2007), however, argues for the stricter 95-95 rule
on the grounds that it offers greater protection against an ineffective medical compound
being approved in the event that the results of the previous trials used to establish the active
control effect are of questionable relevance to the current setting. Accordingly we
evaluate (14.5) with γ = 0.95, f0 = 0.5, ln ̂(λp/λc) = 0.234 and se[ln ̂(λp/λc)] = 0.075 thereby
obtaining the non inferiority margin to be δ0 = 0.044 for the log hazard ratio and
exp(0.044) = 1.045 for the hazard ratio.

14.3 Design of Metastatic Colorectal Cancer Trial

In this section we will use East to design a single-look non inferiority trial comparing the test
drug Xeloda (treament t) to the active control 5FU+LV (treatment c) for the treatment of
metastatic colorectal cancer. On the basis of a meta analysis of ten previous studies of the
active control versus placebo (Rothman et. al. 2003), a non inferiority margin of 1.045 for

14.3 Trial Design 317



<<< Contents * Index >>>

Chapter 14: Non Inferiority Trials GivenAccrual Duration and StudyDuration

λt/λc has been established. Thus we are interested in testing the null hypothesis of inferiority
H0: λt/λc ≥ 1.045 versus the one-sided alternative hypothesis that λt/λc < 1.045. Suppose the
trial is planned to enroll for 30 months and finish within 70 months of the last patient enrolled.

14.3.1 Single-Look Design

We will use East to create an initial single-look design having 80% power to detect the
alternative hypothesis H1: λt/λc = 1 with a one sided level-0.025 non-inferiority test.

To begin click Survival: Two Samples on the Design tab and then click Parallel Design:
Logrank Test Given Accrual Duration and Study Duration as shown below.

A new screen will appear. Enter the appropriate design parameters into the dialog box as
shown below.

The box labeled Variance of Log Hazard Ratio specifies whether the calculation of the
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required number of events is to be based on the variance estimate of the log hazard ratio
under the null hypothesis or the alternative hypothesis. The default choice in East is Null.
Most textbooks recommend this choice as well (see, for example Collett, 1994, equation (2.21)
specialized to no ties). It will usually not be necessary to change this default. For a technical
discussion of this issue refer to Appendix ??, Section ??.

Next click on the Accrual/Dropout Info tab. Here we will specify the accrual information and
dropout rates. Set the accrual duration to 30 months and the study duration to 100 months in
the Accrual Info box. Also, suppose that there are 5% drop-outs per year in each arm. Enter
these values as shown below.

Click on Compute to complete the design. The design is shown as a row in the Output
Preview located in the lower pane of this window. You can select this design by clicking

anywhere along the row in the Output Preview. With Des1 selected, click the icon to
display the details of this design in the upper pane, which are shown below. You may also wish
to save this design. Select Des1 in the Output Preview window and click the to save
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this design to Workbook1 in the Library.

It is immediately evident that Des1 is untenable. It requires 16,205 events to be fully powered
and 18,527 subjects to obtain those events within the course of the study. The problem lies
with trying to power the trial to detect a hazard ratio of 1 under the alternative hypothesis.
Suppose instead that the investigators actually believe that the treatment is slightly superior to
the active control, but the difference is too small to be detected in a superiority trial. In that
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case a non-inferiority design powered at a hazard ratio less than 1 (0.95, say) would be a better
option because such a trial would require fewer events.

To see this create a new design by selecting Des1 in the Library, and clicking the icon
on the Library toolbar. Then edit this design by specifying a hazard ratio of 0.95 under the
alternative hypothesis as shown below.

Click the Compute button to generate output for Des2. With Des2 selected in the Output
Preview, click the icon to save Des2 to the Library. In the Library, select the rows for

Des1 and Des2, by holding the Ctrl key, and then click the icon. The upper pane will
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display the details of the two designs side-by-side:

Des2 is clearly easier to implement than Des1. It requires only 3,457 events to be fully
powered. This can be achieved with only 3,973 patients enrolled in the study.

14.3.2 Early Stopping for Futility

Under the null hypothesis, Des2, with 3,457 events, has an expected study duration of 93.2
months. This is a very long time commitment for a trial that is unlikely to be successful.
Therefore it would be a good idea to introduce a futility boundary for possible early stopping.
Since we wish to be fairly aggressive about early stopping for futility we will generate the
futility boundary from the Gamma(−1) β spending function. On the other hand since there no
interest in early stopping for efficacy we will not use an efficacy boundary.
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Create a new design by selecting Des2 in the Library, and clicking the icon on the
Library toolbar. Change the number of looks from 1 to 3 as shown below.

Next, click on the Boundary Info tab. Enter the parameters as shown below. Be sure to select
the Non Binding option. This choice gives us the flexibility to continue the trial even if a
futility boundary has been crossed. Data monitoring committees usually want this flexibility;
for example, to follow a secondary endpoint.

Click the Compute button to generate output for Des3. With Des3 selected in the Output
Preview, click the icon to save Des3 to the Library. In the Library, select the rows for

Des1, Des2, and Des3 by holding the Ctrl key, and then click the icon. The upper pane
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will display the details of the three designs side-by-side:

Observe that while the sample size has been inflated to 4,344 subjects compared to Des2, the
expected study duration under H0 has been cut down to 39.6 months and the expected
sample size under H0 is 3,965. It would also be useful to simulate Des3 under a variety of

scenarios for the hazard ratio. Select Des3 in the Library and click the icon. You will be
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taken to the following simulation worksheet.

We wish to simulate this trial under the null hypothesis that the hazard ratio is
exp(0.044) = 1.045. To do this go to the Response Generation Info tab in the simulation
worksheet. In this tab change the control and treatment hazard rates as shown below.

Next, click the Simulate button to simulate 10000 trials. A new row labeled Sim1 will appear in
the Output Preview window. Select Sim1 in the Output Preview and click the icon to
save it to the Library. In the Library, double-click Sim1. A portion of the output is displayed
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below. (The actual values may differ, depending on the starting seed used).

Note that 226 out of the 10000 simulations were unable to reject the alternative hypothesis,
thus confirming (up to Monte Carlo accuracy) that this design achieves a type-1 error of 2.5%.
Also, observe that 51.37% of these trials have crossed the futility boundary at the very first
interim look after only 24.794 months of study duration.
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